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Disclaimer
JKSimBlast is a suite of powerful modular tools for the
simulation and management of blasting data. 2DBench,
2DRing, 2DFace, JKBMS, 2DView, TimeHEx, Design
Importer, StockView and Units are stand-alone modules of
JKSimBlast: 2DBench, 2DRing and 2DFace are used for
the design and editing of blasts in mining and related
applications; JKBMS is used to organize and display the
data associated with blasting; 2DView and TimeHEx are
extended analysis programs for JKSimBlast blasting data;
Design Importer imports data from text files directly to the
blast databases; StockView is for the storage of the
specifications of explosives and accessories; and Units is
for the management of user-defined systems of
measurement. As the program developers do not control
data creation, collection, analysis or interpretation, it is the
sole responsibility of the user to verify that input data are
accurate and appropriate, and that all conditions and
outputs are reasonable and comply with any statutory
requirements.
In no event will Soft-Blast or JKTech be liable for direct,
indirect, special, incidental or consequential damages
arising out of the use of or inability to use the software or
documentation.

ii

JKSimBlast

JKSimBlast

iii

Contents
Introduction ...............................1
Overview ...............................................................1
Conventions...........................................................2
Equipment Requirements ......................................3
Software Installation ..............................................4
Electronic Security Key ....................................14
License File......................................................14
Fast Program Start...........................................15

JKBMS .................................... 17
Overview ..........................................................17
Appearance......................................................18
Data Structure..................................................19
Using BMS .......................................................20
Window Size ....................................................21
General Features.................................................22
Menus ..............................................................22
Function Toolbar ..............................................23
Object Toolbar .................................................24
Blast Displays ..................................................26
Help .................................................................27
Program Settings.................................................28
Options ............................................................28
Tools and Functions ............................................31
Edit...................................................................31
Recycle Bin ......................................................32
iv

JKSimBlast

Searches ......................................................... 33
Reports ............................................................ 34
Utilities ............................................................. 37

JKBMS Tutorial ......................... 41
Setup................................................................... 41
New Database..................................................... 41
Root Object ......................................................... 42
Add Object .......................................................... 43
Add Blasts ........................................................... 46
Add Blast from 2DBench.................................. 47
Import Blasts from a 2DBench Database ......... 48
Create Blast..................................................... 51
Edit the Blast ....................................................... 52
Analyse the Blast................................................. 53

2DBench .................................. 57
Overview ............................................................. 57
Appearance......................................................... 58
Design Modes ..................................................... 59
General Features ................................................ 59
Toolbar ............................................................ 59
Cursor.............................................................. 60
Selection Box / Mask ....................................... 60
Zoom ............................................................... 60
Blast Parameters ............................................. 60
Marking............................................................ 60
Query (information display).............................. 61
Help ................................................................. 61
JKSimBlast

v

Sample Blasts ..................................................61
Tools & Keys....................................................62

2DBench Tutorial ...................... 65
Creating a Blast Design....................................65
Drilling Holes ....................................................65
Saving the blast................................................67
Draw Lines and Polygons.................................68
Loading Decks..................................................69
Design Factors.................................................71
Downhole Delays .............................................72
Surface Delays.................................................74
Detonation Simulation ......................................78
Basic Analyses.................................................80

2DRing .................................... 83
General Functions ...............................................83
Design Area.........................................................83
Screen Layout..................................................83
Design Area Appearance .................................85
Global Construction Tools....................................91
Selection Box ...................................................91
Selection mask.................................................91
Goto Position ...................................................91
Anchor .............................................................92
Specify Zoom ...................................................92
Zoom in, Zoom Out, Previous Zoom.................93
Centre Design, Select Nearest Object..............93
View Define......................................................93
Hole Marking....................................................94
vi

JKSimBlast

Redraw ............................................................ 95
Query Options ..................................................... 96
Object Query.................................................... 96
Loading & Saving ................................................ 99
Importing and Exporting .................................... 101
Importing String Information........................... 101
Exporting Data ............................................... 106
Reporting........................................................... 108
Printing .......................................................... 108
Design Input ...................................................... 111
Definition and Selection of Ring Planes............. 111
Definition of Boundaries .................................... 114
String Line and Polygon Creation................... 114
Drill Drives and Drill positions ............................ 117
Drill Drives ..................................................... 117
Drill Positions................................................. 119
Blast Hole Drilling .............................................. 120
Selection and Loading of Explosives ................. 123
Selection and Loading of Delay Detonators....... 125
Downhole Delays........................................... 125
Surface Delays .............................................. 126
Engineering Tools and Analysis ........................ 128
Detonation Simulation ....................................... 128
Explosive Energy Distribution ............................ 130
Static 3-D Explosive Distribution .................... 130
Dynamic 4-D Explosive Distribution ............... 131
Calculation of Explosive Distribution. ............. 133
Fragmentation ................................................... 137
JKSimBlast

vii

2DFace ................................. 145
General Functions.............................................145
Design Area.......................................................145
Screen Layout................................................145
Design Area Appearance ...............................147
Global Construction Tools..................................152
Selection Box .................................................152
Selection mask...............................................152
Goto Position .................................................152
Anchor ...........................................................153
Specify Zoom .................................................153
Zoom In, Zoom Out, Previous Zoom ..............154
Centre Design, Select Nearest Object............154
View Define....................................................154
Hole Marking..................................................155
Hole Dragging and Dropping..........................156
Redraw ..........................................................156
Query Options ...................................................157
Object Query..................................................157
Design Summary Information .........................158
Loading & Saving...............................................160
Importing and Exporting .................................161
Importing String Information ...........................162
Exporting data................................................167
Reporting...........................................................168
Printing...........................................................168
Design Input ......................................................171
Area to be Blasted .............................................171
String Creation to Define Blast Regions .........171
viii

JKSimBlast

Development Rounds (Drive Outlines).............. 174
Specify Sections of Current Drive .................. 176
Blast Hole Drilling .............................................. 178
Single Hole Mode .......................................... 180
Burn Cuts....................................................... 180
Multiple Holes ................................................ 182
Drilling Holes around a Circle......................... 185
Selection and Loading of Explosives ................. 187
Selection & Loading of Delay Detonators .......... 189
Downhole delays ........................................... 189
Surface delays ............................................... 190
Engineering Tools & Analysis ............................ 192
Image Digitiser .................................................. 192
Explosive Energy Distribution ............................ 196
Static 3-D Explosive Distribution .................... 196
Dynamic 4-D Explosive Distribution ............... 198
Calculation of 3D / 4D Explosive Distribution. 198
Detonation Simulation and Time Contouring ..... 201

2DView .................................. 207
Overview ........................................................... 207
Opening a Blast................................................. 209
Open a Blast.................................................. 209
Add a Blast .................................................... 210
Viewing a Blast.................................................. 212
Define View ................................................... 212
Scroll Bars ..................................................... 215
Defining a View "Plane" ................................. 216
Printing.............................................................. 218
JKSimBlast

ix

Calculation Region.............................................220
Creating a Calculation Region........................221
Polygon Method .............................................221
Draw a Region ...............................................222
Modify Regions ..............................................223
Explosive Energy Distribution ............................226
Starting a Distribution Calculation ..................227
Calculation Parameters..................................228
Displaying Results..........................................230
4D Energy Distribution ...................................232
2DContour .........................................................234
Contour Control..............................................235
Contour Scale ................................................238
Adding Custom Contour Values .....................240

Ti me H Ex ................................ 243
Overview ...........................................................243
Maximum Instantaneous Charge .......................244
Design View.......................................................248

x

JKSimBlast

JKSimBlast

xi

Intr oduction
Overview
JKSimBlast covers the design, editing, simulation, analysis Overview
and management of blasting in mining and related
operations. The main modules are 2DBench, 2DRing and
2DFace. These are graphical software programs for the
design and editing of blasts: 2DBench applies to bench
blasting in surface mines; 2DRing applies to underground
ring blasting; and 2DFace applies to underground tunneling
and development. The three programs give engineers and
blasting personnel the ability to design and optimise the
layout and initiation sequence of almost any type of blast
used in mining. Each allows the designer to:
layout a pattern of blastholes
load explosive decks and other materials in the holes
install downhole and surface delays, with primer and
connection details
simulate the detonation on screen
import and export data and print the blast
Individual elements of the blast are defined by the user,
including hole dimensions, explosives, delays, connectors
and boosters, and can be combined in a variety of blast
scenarios.

The design modules include detailed analysis tools to
calculate blast properties, summarise quantities and
consumables, and interpret blast performance. Other
modules in JKSimBlast provide for extended analysis of
blast layouts and energy (2DView, Energy and 2DContour)
and blast timing (TimeHEx).
Data management is
JKSimBlast
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provided by JKBMS (Blast Management System). Thus
JKSimBlast is a framework for a suite of programs for data
management in blasting, including design and simulation,
analysis, data collection and referencing, performance
evaluation, prediction and optimisation. Integration of the
modules is achieved through data sharing via Microsoft
Access databases. The open framework allows for other
third party applications to be developed and incorporated
into JKSimBlast, using the same databases for their own
purposes.
This approach provides the user with a
mechanism to maximise the use of the data.
This manual describes the basic and commonly used
features of the programs. More detail on JKSimBlast and
the modules is contained on the CD and in the various
sections of this manual, and in the on-line help with each
module.

Conventions
used in this
manual

Conventions
[click] click the left mouse button once
[double click] click the left mouse button twice
[right click] click the right mouse button once
[drag]

click and hold the left mouse button, move the
mouse, then release the left mouse button

[…]

press the key, button or tab shown
do not press [Shift] unless indicated

[…]+[…]
>italic

2

press the keys together

means a menu option
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Equipment Requirements
JKSimBlast runs on a personal computer under Microsoft Equipment
Windows 98 / NT4 / 2000 / XP.
The recommended Requirements
minimum requirements for running JKSimBlast are:
16 MB of random access memory (RAM)
CD disk drive (for installation)
hard disk drive with 65 MB of free space, plus 85 MB
of temporary free space for installation
SVGA graphics (800 x 600 display)
mouse
The installation program requires about 85 MB of free
space for the temporary installation files, which are
removed when the installation is completed. The full suite
of JKSimBlast program files occupy about 45 MB of disk
space, with a further 20 MB taken up by system files,
mostly in the Windows System folder. Some of these files
may be already present on the computer, so the final disk
space requirement may be less than that stated above.
Additional space will be required for blast database files
created by the user in the operation of the program.
All JKSimBlast modules are designed for SVGA graphics
(800 x 600 pixels). Although it will operate in VGA mode
(640 x 480), some of the items may be obscured or cut off
in the smaller screen area, such as dialog boxes, query
windows and status line messages.
JKSimBlast uses an electronic security key, which must be
attached to the computer before each module can run.
Additional and replacement keys can be obtained from
Soft-Blast.

JKSimBlast
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Software
Installation

Software Installation
Before proceeding:
For Windows NT, 2000 or XP, you may need
Administrator privileges for software installation.
JKSimBlast uses an electronic security key and a matching
license file as the license control for the software. You will
need both of these items to run the software.
Installing JKSimBlast
The installation program for JKSimBlast is used to install
any or all of the modules, plus the drivers for the electronic
security key. You have a choice to install either a complete
system for Surface Blasting or Underground Blasting, or
individual components (see the JKSimBlast overview on
the CD for more details).
You will need an appropriate license file to run the main
modules of JKSimBlast - JKBMS, 2DBench, 2DRing,
2DFace, 2DView, Energy, 2DContour and TimeHEx. This
file is supplied as part of the purchase of the software.
Instructions for installing the license file are at the end of
the section below. The utility modules StockView, Import
and Units do not require a security key or license file in
order to operate.
In the installation instructions, [disk]: refers to the drive
letter of your CD drive.
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1. Start the installation program
To install all of the modules in JKSimBlast, you will need
about 150MB of free space on your hard drive. This
includes 85MB of temporary space for the install program.
Installing only one module, such as 2DBench or 2DRing,
requires about 120MB.
To start the installation, run the program

[disk]:\install\JKSimBlast\Setup_JKSimBlast_v2.exe

Select [Open] or [Run from this location] if the program
does not start by itself. Alternatively, you can copy the
install program to a hard drive and run it from there.
Once the installation program starts, follow the on-screen
instructions.

2. Wait ...
The install program will create a temporary folder on your
hard drive to hold the extracted installation files. This is a
very large file, so it could take a few minutes. For example,
on a 500MHz computer running Windows 2000, the
extraction can take up to 1½ minutes. Please be patient.

JKSimBlast
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3. License Agreement
[Click] the button to accept the license agreement and
proceed. A copy of the license agreement is on the disk, in
the JKSimBlast install folder.

6

JKSimBlast

Introduction

4. Customer Information
Enter your name and organisation, if they are not already
shown. This is internal information only, for the operating
system.

JKSimBlast
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5. Destination Folder
Either accept the default installation folder, or click
[Change] to select a new folder.
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6. Setup Type
Select the type of installation:
o option 1: JKSimBlast for Surface Blasting
o option 2: JKSimBlast for Underground Blasting
o option 3: custom setup for all others, including
JKSimBlast for Tunnel Blasting

JKSimBlast
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7. Custom Setup
Use the Custom Setup to install individual components.
Note that the components StockView, Import and Units are
always installed.
To install JKSimBlast for Tunnel Blasting, select the
components 2DFace, TimeHEx, 2DView and JKBMS.
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Select how and when to install each component - typically,
always select the first option ...

JKSimBlast
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For example, to install only 2DBench, the screen should
look like this ...
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8. Ready to install
The software is now ready to install. Check the details, and
click [Install] to continue.

JKSimBlast
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Electronic
Security Key

Electronic Security Key
All of the main JKSimBlast modules require an electronic
security key to operate. The drivers for running either a
USB key or an LPT key (for the parallel printer port) are
installed with the program.
The Hardlock drivers can also be installed independently, if
required, by running the program hldrv32.exe from the
Hardlock folder on the CD.

License File

License File
To complete the installation, copy the license file
license.nfo to the main JKSimBlast folder (typically
C:\Program Files\JKSimBlast). The license file contains
details of the modules that are permitted to run with
each electronic security key.
The license file should either be on the CD in the
JKSimBlast folder, or supplied by email as an attachment.
If you do not have a license file, contact Soft-Blast.
Include the name of your organisation, contact person and
the serial number of your electronic security key.
Once the license file is in place, plug in the security key
and start the software.
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Fast Program Start
The programs JKBMS, 2DBench, 2DRing and 2DFace Fast Program
may take a long time to start at the first run, but should start Start
almost immediately on subsequent runs. At the first run,
the programs search internally for details of the electronic
security key.
These details are then stored in an
initialisation file in the program folder, and are used in
subsequent runs to enable faster start-up.
If a program does take a long time to start, a fast start can
be forced by modifying the shortcut to the program. Select
>Help >About, and note the code in square brackets at the
bottom of the form, e.g. [G123]. [Right click] on any
shortcut for starting the program (including the Start
menu), and select Properties from the pop-up menu. At the
end of the Target line, add /local=G123. For example:
"C:\Program Files\JKSim…2DBench.exe" /local=G123

Close the Properties, then restart the program from the
shortcut. It should start almost immediately.
For a network license, the code is in the form [Nnnn], and
the startup command is /net=Nnnn.

JKSimBlast
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Overview

The Blast Management System (BMS) allows the user to Overview
store, organise and access information related to drill and
blast operations in mines. The information can include pit
and blast geometry, geotechnical and blasting domains,
drilling parameters, costs, fragmentation distributions,
vibration results, specific reports, comments, etc.
The BMS uses an object based approach in a hierarchical
tree structure for the storage and management of blast data.
Information attached to an object is stored in a Microsoft
Access database linked to the program, either as a set of
data relevant to the object or as a pointer to a separate file
where the data is stored. This avoids duplication and keeps
the size of the BMS database to a minimum, and ensures
that other programs can continue to access external data
files without any limitations imposed by the BMS.
Although the BMS can store production data for drill and
blast operations, it is not intended to replace or act as a
continuous production reporting system. Its purpose is to
organise blasting information, in order to facilitate the
design, modification and analysis of blasts. Often, while
designing a new blast or making ongoing modifications to
a current blast, an engineer or blaster may need to include
specific parameters or review results from previous blasts.
The BMS can provide rapid access to that information in a
simple, intuitive format.
The program both complements and extends the use of the
JKSimBlast blast modules 2DBench, 2DRing and 2DFace.
This manual describes the setup for an open pit database,
highlighting its connectivity with the 2DBench module.
Apart from minor differences in the types and appearance
of some of the objects and their data, the process is the
same for the other blast modules.
JKSimBlast
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Appearance

Appearance
title bar

current BMS database

menu bar

files, display, search, tools, options

function toolbar

control of the tree structure

object toolbar

creation of objects in the tree structure

main window

displays the tree structure

status bar

information about selected object

Title Bar
Menu
Bar
Function
Toolbar
Object
Toolbar

Main Window

Status
Bar
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Data Structure
Data Structure
The BMS uses hierarchical, or parent-child, relationships to
build a tree structure of the blast data. Each type of data
object (e.g. pit, bench, blast) is given a unique
identification, and can be both a child of one object and a
parent to others. A single sequence of parents and children
is called a branch, with each point in the branch, called a
node, holding one object. The starting point for a tree is
called the root object. A single BMS database can have
several root objects, and thus several trees.

Root
Object
Parent of
Domain
Objects
Children

Each object in the tree is defined by three properties: its
unique object ID number (shown in the status bar), its
parent’s ID number, and the object type. Each object also
has a name which can be modified by the user.
Information is added to an object either by [double-click]
on the object or [right-click] and select an option from the
pop-up menu. Some objects do not accept any further
information (such as open pit or blast collection), and only
exist to help create a logical tree structure, similar to a
folder in Windows Explorer. Other objects hold data about
the object or a link to an external data source, or in some
cases both. In particular, detailed blast information is
stored in the original 2DBench, 2DRing or 2DFace
JKSimBlast
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databases, and the BMS program communicates directly
with these databases.
In general, objects can be added to the tree at any position
that the user wishes, except for a few particular objects
controlled by in-built rules. For example, a blast can only
be added to a blast collection.

Using BMS

Using BMS
BMS stores its data in a Microsoft Access database, with
the extension “.bms”. The databases are fully compatible
with MS Access and can be opened in MS Access. This
should be done with care, to prevent accidental changes or
damage to the structure or contents of the database.
Any number of BMS databases can be created, but only
one can be opened at a time. Databases can be created as
new databases or from a subset of the current database.
Several databases can also be merged into one database by
inserting in the current database.
It is recommended to create new databases to prevent a
decrease in performance of the program caused by
excessively large database files. If this occurs, separate the
database into logical units, for example by date, location or
application.
While the BMS program is in use it remains attached, or
bound, to the current database. This means that any
changes made in the program are immediately stored in the
database. This is different from the other programs in
JKSimBlast, which do not save any changes until Save is
selected from the menu.
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When a BMS database is opened, it is locked to prevent
other users from making changes. However, other users
can view the contents of a locked database in read-only
mode. The program checks at regular intervals for the lock
file (*.ldb), which is removed when the first user closes his
copy of BMS. A new lock file is then created for the next
user, and the data tree is rebuilt to include any changes
made by the previous user.
The BMS can also open blast databases from 2DBench,
(*.2db), 2DRing (*.2dr) and 2DFace (*.2df). However,
only some limited functions can be performed in this mode.
o

Use only the options under the pop-up menu ([rightclick] on a blast): delete, cut, copy, paste, rename, and
properties.

o

Do not use any other functions under the menus, except
those listed above. The menus are not disabled, but if
any other items are selected, the program will crash.

Window Size
Window Size
BMS is primarily designed to work with the blast design
and analysis modules of JKSimBlast: 2DBench, 2DRing
and 2DFace. To facilitate this, if the BMS window is
placed on either the left or right side of the screen, and
reduced to less than 1/3 of the screen width, the design
modules will open automatically in the remaining space.
This will allow the user to move easily between the two
programs. If more than one design module is open, they
will all occupy the same space on the screen.

JKSimBlast
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General Features
Menus

Menus
Two menus are available in BMS. The main menu is
located at the top of the screen, immediately below the title
bar. All of the program functions (except some specific
blast functions) can be accessed from the main menu.
The menus also show any corresponding keystrokes that
can activate the same functions.

main menu

A secondary menu can be opened by a [right-click] with
the mouse on any object. Most of the options in this menu
are available from the main menu, but some objects will
show additional options: in particular, a blast collection
will include options for creating and importing blasts, and a
blast will include options to create specific reports.

pop-up menu
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Toolbar

Function Toolbar

The function toolbar includes the main tools to open and
save databases and display the tree structure.
Open Database open an existing database for
modification (if not already in use) or display
only (if in use).
Menu option: >File >Open Existing Db
Save As… save the current database under a new
name
Create New Database create a new, empty BMS
database, from the template file Template.mdb in
the Templates sub-folder
Add New Root Object create a new top-level node
on the tree. This must be done first for a new
database.
Open All Branches expand all branches in the tree,
so that all nodes are visible.
Close All Branches shrink all branches in the tree,
so that only the root objects are visible.
Show Recycle Bin opens the recycle bin in a
separate window. If the recycle bin contains any
objects, it will also be visible on the tree.
Clear Search Results clears the list of found objects
from the last search.
go directly to found items:
first, previous, next, last
JKSimBlast
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Object Toolbar Object Toolbar

The object toolbar and the >Add Objects menu contain
various items that can be added as nodes to the tree.
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To add a node, first select the parent node, then [click] any
item on the object toolbar to create it as a child node.
Objects in the tree have generic and specific properties.
Both of these are accessible from the >Properties menu,
but only the specific properties appear in the pop-up menu
([right-click] on an object in the tree).
In most cases, a [double-click] on an object will display the
specific properties. The major exception is the generic file
object, which will activate the linked file.
The generic properties include the dates when the object
was created and last modified, and the name of the user
profile at the time. Descriptions, comments and notes can
also be added to the generic properties.
The specific properties depend on the purpose of the object.
o No properties - the object is only used to help define
the structure of the tree, e.g. open pit
o Description - these describe the object, but are not
used for any other purpose, e.g. top and
bottom levels for a bench
o Data Store - the object has data stored with it in the
BMS database, e.g. surface, graph, joint sets
o Collection - a holder for other, specific objects, e.g.
blasts, photos, energy distributions. Only
these objects can be added to the collections.
o File Link - stores the name and location of an external
file, e.g. generic, photo and video
collections.
o Blast Link - stores the blast and database name and
location for blasts created in the JKSimBlast
design modules.
JKSimBlast
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Blast Displays

Blast Displays
There are two types of display for blasts, in 2D or 3D.
All blasts are displayed in 2D with the specific properties
for a blast collection. Bench blasts are displayed in plan,
and ring and face blasts are projected to a section view
looking in one of the main orthogonal directions (north,
south, east, west, up, down).
Bench blasts can also be displayed in a separate plan view
window, by [right-click] and select Plan View from the
pop-up menu. This can be done for any node on the tree,
and all bench blasts in branches below that node will be
displayed.
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The 3D Viewer can display any blast, plus also surfaces,
energy distributions and PPV distributions. As for the plan
view, this can be activated at any node in the tree to display
all relevant data attached to the branch.

Help
Help
On-line help is accessible from most dialog boxes and
forms, either from a [Help] button or by pressing the [F1]
key.

JKSimBlast
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Program Settings
Options

Options
When you first run the JKBMS you can immediately begin
to use it to start organising the blasting related data for your
mining operation. However, there are a few options you
will first need to set under the >Tools >Options menu to
save having to set them later on.
The settings are stored in the Windows registry where
JKBMS is installed.
Nodes
Return to Last Node on Start Up: If you want to go
back to the last node visited each time you open the
program, check this option.
Open Tree on Start Up: If this option is left
unchecked then the tree will not appear fully open when
you start the program. If the previous option is checked
then the tree will only open up the direct ancestors of
the last node visited. If it is checked then all nodes will
be shown (i.e. the tree will be fully open) and the
current node will be highlighted.
Confirm Addition of New Children: The program
will ask for confirmation each time you add a node.
Confirm Node Deletion: The program will ask for
confirmation each time you delete a node.
Double Click runs file in associated external
program: If the node is a generic file object, a [doubleclick] on the node will open the file in its associated
program, as defined in the specific properties for the
node. If the node is a blast, it will open the blast in the
relevant JKSimBlast design module.
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Always try to run JKSimBlast application after
creating a blast design: When a blast is created in the
BMS as a new node, this option will automatically start
the relevant design module.
During load - Sort each Tree list level by: This
determines how sibling nodes (i.e. nodes with the same
parent) are ordered in the hierarchy. For a consistent
sequence of object types within a branch, select Type
and Name.
Paths
JKBMS can open blasts in the JKSimBlast design modules
and create blasts from imported data. This tab defines
where to find the design modules and other files. Usually,
these options are set by the program when it is first run, but
can be set manually if necessary.
To set the location of the program files, click the browse
button […] to the right of each of the text box. Locate the
relevant program file and click [Open] to set the folder
location.
The Templates folder contains the template databases used
to create new blast databases. This is necessary if a new
blast is created in the JKBMS program. In this case, select
the folder from the form and click [OK].
2DBench blasts can be opened in either the 2DBench or
2DView programs. Select a button to set the default
option.
Each of the JKSimBlast design modules can start with an
.ini file, which sets some user specific options. The
programs always start with the default .ini files, but userspecified files can also be used. Click the [INI File
Location] button to select specific .ini files for the design
JKSimBlast
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modules. Ensure that the [Use these Ini Files...] checkbox
has been selected.
If you have the Split-Desktop program (image analysis of
photos of fragmentation), you can also set the path to the
program. The fragmentation object has an option to
activate the program with the attached photos.
Viewing
These options determine how blasts and other data are
displayed in the 3D Viewer.
Show Strings with Blasts: Any strings in a blast will
be displayed along with the blast. Turn this off if the
performance of the 3DViewer is being affected.
Show Ties with Blasts:
connections with the blast.

Shows surface delay

Show Holes as... Either show blast holes as cylinders
(drawn to scale), or only as the centre line of the hole.
This will also affect the performance of the viewer.
3DView Far Plane Value: The distance at which the
rendered objects in the 3D Viewer are clipped. See the
on-line help for The Eye and Target Coordinate Display
for more information.
3DView Default Background Colour:
The
background colour of the render window in the 3D
Viewer. [Click] the coloured box to change the colour.
3DView Default Blast Colour: The default colour
which blasts are shown in. If a colour has been defined
in the generic properties of the blast object, then this
overrides this value. [Click] the coloured box to change
the colour.
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Miscellaneous
The Misc. tab contains options for using stocks (explosives
and accessories) and units in the JKBMS. These options
are used with Blast Result and Cost objects, and for
exporting data for reports.
See the on-line help for more information.

Tools and Functions
Edit

Edit
There are several tools for modifying objects in the tree.
These tools are available from either the pop-up menu or
the >Edit menu.
Note: there is no Undo. Once an editing tool has been
completed, it is not possible to restore the object to its
previous condition.
Delete Object
Move an object and all its children to the Recycle Bin.
These objects can be restored until the recycle bin is
emptied.
Rename Object
Change the name of an object in the tree. This does not
affect the names of any specific properties or linked data.
Move Object to Root
Moves an object from its current parent to the top-level in
the tree. This can also be done by deleting the object and
restoring from the Recycle Bin as a root object.
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Cut
Move object to the cut buffer. Note that the cut buffer
operates differently to the normal windows buffer in that
you can cut several objects and then paste them all to the
same parent. The cut objects are also persistent, i.e. they
will remain in the cut buffer of the database, even if the
program is closed, until they are pasted.
Copy
Make a copy of an object and insert it as a sibling to the
original object, i.e. under the same parent. You have the
option of copying the object specific information as well
(i.e. not just the generic properties). To copy to a different
parent, first copy, then cut the copy and paste under a
different parent.
Paste
Paste any cut objects as children of the selected node.

Recycle Bin

Recycle Bin
The JKBMS Recycle Bin operates in much the same way
as the Windows Recycle Bin. Any deleted object goes to
the recycle bin before actually being removed from the
database. Any object in the Recycle Bin can be restored as
either a child of the current node, child of its old parent (if
it still exists) or as a root object.
The Recycle Bin appears automatically on the tree if it
contains any objects. To display it, either [double-click] it
on the tree, or [click] the [Recycle Bin] button on the main
toolbar.
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To empty the Recycle Bin, [right-click] on the Recycle Bin
node and select Empty Recycle Bin from the popup menu.

Searches
Searches
There are four search tools provided in JKBMS. In all
cases, the search results are placed in a list, and each item
can be quickly accessed by the Goto buttons on the toolbar.

Found objects are indicated in the tree by a bold font. If
the node is not visible, because the branch is closed, the
parent node is highlighted. If the Goto buttons are used,
the branch will be automatically opened.
go to items in search list:
first, previous, next, last
clear the found list. All of the searches
include [Reset] buttons to clear the list.
Rebuilding the tree will also clear the list.
The four searches are located under >Edit >Find and
>Tools> >Query.
Find / Quick Query
Search the generic properties to find objects by name, type
or date.
Query Builder
A more advanced version of the Quick Query for generic
properties only.. The criteria from this search cannot be
saved by in the BMS, but can be copied and pasted
between the criteria box and another application
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3D Query
Search for either blasts or survey points by their
coordinates. Enter a single point as the centre of the
search, and a window range in each direction around the
centre. The search will locate any data points attached to
blasts or survey points that fall within the window. The
criteria for this search can be saved and recalled again for
later use.
Find Blast By Result
Search Blast Result and Fragmentation objects for a blast.
In this case, the parent blast of the successful results is
selected. The criteria for this search can be saved to an
external file.
Reports

Reports
JKBMS can generate several Excel reports for blasts.
These can be accessed from either the >Tools menu or the
pop-up menu for a selected blast. For further information
about the included Excel reports, consult the on-line help.
There are two other reporting options that export the blast
data as text files.
The first output, the Blast Summary Report, creates a
summary of the various components of the blast: holes,
explosives, and delays. All of the data is exported to a
single file that contains a short summary of the totals for
each blast, and the total for all blasts, followed by the
details for each blast for each of the blast components.
(Note: the Summary Report can only report bench blasts.)
The second output, the Export Report, contains all of the
raw data for the selected blasts, with one text file per blast,
with the name of the blast as the file name. This is,
basically, a download of the data stored in the blast
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databases. The data is provided in tables for each
component of the blast, including properties of explosives
and delays used in the blast. The format is the same in
each file; the only difference is the number of lines in each
table, depending on the number of holes, decks, delays, etc.
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The Export Report also includes a bitmap image file for
each blast. The file has the same name as the text file, with
the extension .bmp. In the case of ring blasts, there is one
bitmap file per ring.

Both outputs are tab-delimited, which makes them suitable
for opening in a spreadsheet and further formatting and
calculation.
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Both report options operate in a similar fashion. The
dialogs present a list of blasts from which the user can
select for export. The list can be filtered by date, scenario
or blast type. Export Report also includes options for the
blast components to include and the details shown in the
blast image.
Initially, only blasts below the selected node are shown in
the list. To include all blasts in the current BMS database,
select the check box for [Include all blasts].
In Blast Summary Report, click [Copy] to send the output
directly to the clipboard, or [Save] to write to a nominated
file.
In Export Report, click […] to select the folder where the
ouptput files are to be stored, then [Continue] to produce
the files. The files can also be sent directly to another
application for processing, if it is defined in the [Activate]
list.

Utilities
Utilities
JKBMS includes several utilities for manipulating the tree
structure, file links and blast databases. These include:

extracting a subset of the current BMS database (prune);
merging BMS databases (insert database);
display only one branch = hide other branches (prune
this branch);
repair links to external files, e.g. when the files have
been moved to another folder;
move and copy external files from within BMS;
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archive a BMS database and all linked files;
move or copy blasts from one blast database to another.
These utilities are discussed in the on-line help.
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Setup
This tutorial will take you through the basic steps for
creating a BMS database.

Setup

A BMS database must contain at least one root object.
Further objects are added to the tree to represent the
distribution of the data, either by location or relationship, or
both. As each object is added, specific properties are
entered to create records of the blasts. Other files are
added to build a complete history of blasting operations.
The first step is to start the program. Enter a name on the
start screen – this will be the name of the user profile. This
is used to recall the last settings for that profile.
If this is the first time that the BMS program has been used
after installation, it should ask you several questions about
storing the profile and file associations. If it does not, or if
you wish to change them, check the options under Program
Settings.

New Database
To create a new database, [click] the button on the toolbar
or select >File >Create New Db.
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You will be prompted to enter a name for the new database,
and select a folder. The BMS database canm be stored
anywhere on your computer system.
Alternatively, you can objects to the current BMS database.

Root Object

Root Object
If you have created a new database, the [add new root
object] button on the main toolbar will be turned on. This
means that you must create at least one root object for the
new database.

If the button is not on, [click] it to turn it on. Now, [click]
any button in the object toolbar to create that item as a new
root object.
In general, start with a site (circled above) as a root object,
and then add further objects to represent the structure of the
mine.
To change the name of an object, [right-click] the node and
select Rename Object from the op-up menu.
You can add as many root objects as you wish to the tree.
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Add Object
Add Object
To add objects as nodes, first select the parent node on the
tree by a single [click] on the node. Then, [click] one of
the icons in the object toolbar to add that as a child node
below the selected node.

To add another object as a child to the same node, [click]
the desired icon in the object toolbar. You can add as many
nodes as you wish at one time, including duplicates of any
object.
As it is added, each node is assigned a unique ID number in
the BMS database. The ID number, object type and object
name are displayed in the status bar at the bottom of the
window when the node is selected.

The main concern at this point is to create a reasonable
hierarchy for the tree that represents the structure of your
JKSimBlast
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mine.
This will make it easier to quickly locate
information in the tree, which could be crucial to the
correct design and recording of blasts. It is possible to
modify the tree later, but good planning now is a better
approach.
In this case, the mine has two pits. Two benches have been
identified within one pit for entry, as well details of a rock
mass within the pit. Objects for each of these have been
added to the tree.
A geotechnical unit is a zone of rock types and joints that is
treated as a single domain for blasting. Its purpose is to
quickly provide information about the rock mass, for
reference only, when you are designing a blast.
When you add a geotechnical unit, also add child nodes for
rock types and joint sets. The geotechnical unit displays
specific properties for the dimensions of the domain, plus a
summary of the specific properties from child nodes for
rock types and joint sets.
The objects can be added to the tree in almost any
sequence. For this example, the geotechnical unit could
have been placed immediately under the site, if it is large
enough to encompass the entire pit. However, if a pit has
more than one domain, then the domains could be placed
inside the pit. Alternatively, all geotechnical units could be
placed in one branch together, separate from the other data,
to reduce clutter in those branches and to make it easier to
find and maintain that data.
If you make a mistake in adding an object, select the node
and press [Delete]. This will move it to the Recycle Bin.
To add specific properties to a node, [double-click] it or
press [Enter]. Some objects have no specific properties,
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such as a site (and are used only to
organize the structure of the tree), while
others have either data or links to
external data, or both. An open pit, for
example, has specific properties to help
to identify the location of the bench.
When the initial tree structure is
complete, select each node in turn, press
[F2] or [right-click] and select Rename
Object, and enter the name for each node.
To sort the tree, select >Tree Options >Rebuild. This will
sort all objects at each level attached to a node according to
the selection in >Tools >Options. The figure below shows
the result for [Type and Name].
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Add Blasts

Add Blasts
To add a blast, you must first add a blast collection. There
are three collection objects, for bench, ring and face blasts.
Each type of blast can only be added to its relevant
collection object.
To add a blast collection, select the parent node on the tree,
then click the blast collection object on the toolbar.

There are three methods to add a blast:
add from a blast design module, such as 2DBench;
import from a JKSimBlast blast database; or
create the blast as a node.
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Add Blast from 2DBench
For this method, both 2DBench and JKBMS must be
running at the same time (the same applies for 2DRing and
2DFace). Create the blast in 2DBench, and save it to a
blast database. After you click the [Save] button in
2DBench, and with JKBMS running, this dialog will
appear:

Select the blast collection from the list, and click the button
[Add Design to selected Blast Collection]. This will create
a link, or reference, in the BMS database to the blast in its
blast database.
Otherwise, if you have selected the correct blast collection
node in JKBMS, you can click the top button, [Add Design
to current Blast Collection selected in JKBMS]. If you
have not selected it, you can go to JKBMS and select it
before clicking the button. This is useful if you cannot
determine the correct collection from the list.
JKSimBlast
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You can click either of the [Add…] buttons to add more
references to the blast, in any selected blast collection.
Click the [Close] button to close the dialog.
Import Blasts from a 2DBench Database
Use this method to add blasts that have been previously
saved from 2DBench (or 2DRing, 2DFace).
[Right-click] on the blast collection node and select >Add
Existing Blasts from the pop-up menu. This dialog
appears:

Click the [Open…] button to select a 2DBench database,
and the blasts in the database will appear in the list below.
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Select the blasts to add; click with the [Shift] and [Ctrl]
keys for multiple selections, click the [Select All…] for all
blasts, or enter some characters in the filter at the bottom
and click the [camera] button to select all blasts with those
characters.
The check box will limit the list to blasts that do not
already exist in the current BMS database.
Click the [+] button to add the selected blasts to the BMS
blast collection. This will create a reference for each blast.
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[Double-click] the blast collection to display all of the
blasts, with a plan view.
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[Right-click] the blast collection node and select >Plan
View to show all of the blasts together in a single plan. The
view will show all of the blasts below the node from where
it was activated. Move the mouse over a blast to display its
name.

Create Blast
This option allows you to add a blast to a collection as a
node. You can name the blast, and then choose to import
the blast data from a text file, or run the blast design
module and create the blast there.
Select the blast collection, then [right-click] and select
>Create New Blast. You will then be prompted to add the
blast to a database – this is similar to saving the blast in the
design module, but it only creates a location for the blast, it
does not create any data.
JKSimBlast
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If you select [No] you will have a new blast with no
reference. You can [right-click] on the new blast and select
>Properties, then [double-click] the blast name to edit the
blast details and attach a reference to an existing blast.
If you select [Yes], then you must select a blast database
where the blast will be linked. Select the database from the
list of current databases, browse for a different database, or
create a new database (you will be prompted for a name
and folder).
Depending on your choice, you will then be prompted for a
name and scenario number for the blast. If you enter or
choose a blast name that already exists in the database, you
will be prompted to create a reference to the blast. Select
[Yes] to continue, or [No] to go back and enter a different
name or scenario.
Next, you will be asked if you wish to run the Design
Importer, to import the blast from a text file. This is the
same process as in the design modules to import a blast.
As the final step, the blast design module will open, and
will open the new blast if it exists, or you can create the
blast.

Edit the Blast
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Edit the Blast
To edit a blast in the relevant design module, either
[double-click] the blast in the collection (if you have
selected the correct option in the program options), or open
the Properties in BMS (for either the blast or the collection)
and click the edit icon in the top left corner of the
properties form.
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The blast will open in the relevant design module. Any
pre-existing data will be lost.

Analyse the

Analyse the Blast
Blast
JKBMS cannot perform any analyses within the program,
but it can store or reference the results of analyses from
other sources, and these can be viewed in JKBMS. These
can be added to the blast as child objects, as for any other
objects.
Some of the useful objects for analyses are:
Photo Collection. Each photo is stored as a link to a
file, with individual notes. The photos can be
viewed with the internal viewer, or opened in the
default viewer application.
Video Collection. Each video is stored as a link to a
file, with individual notes. The videos can be
opened in the default viewer application.
Vibration. Enter the summarised results for various
vibration measurements.
Fragmentation Distribution. Enter the fragmentation
distribution data (as percent passing and size),
and display as a graph. Several sets of data can
be entered, or pasted, and displayed together for
comparison.
Graph. Store and display time-based data as a graph.
Energy Distribution. A collection of energy
distribution results from a JKSimBlast design
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module. The data can be filtered to control the
display, and shown in 3D with the blast.
PPV Damage Contours. A collection of PPV
contour results from a JKSimBlast design
module. The data can be filtered to control the
display, and shown in 3D with the blast.
Generic File. Attach any data file with an
application that can process it. [Double-click] to
automatically run the application.
These objects are designed to make it easy to recall and
display other data associated with a blast, with all
references stored in one location for rapid recall and
comparison. For more information, consult the on-line
help.
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2DBench
Overview
2DBench is a graphical program for the design and analysis
of blasts in benching operations, typically for open cut
mines and quarries.

Overview

The blast is laid out in a 2D plan view, consisting of blast
holes, decks, and downhole and surface delays and
connections. The blast area can be further described by
lines, polygons and labels (collectively known as strings).
Both strings and blast holes can be imported from text files,
either as designs or actual data.
Once the blast layout is complete, a detonation simulation
can be run on-screen. Basic analyses include volume,
tonnage, powder factor, component and total costs and first
detonation contours. Advanced analyses include maximum
instantaneous charge, energy distribution, PPV contours,
dynamic burden relief, and fragmentation.
Although the blast is viewed in 2D plan, all data is created
and stored with full 3D coordinates (east, north, level) in
Microsoft Access databases. Added to this are component
details (hole parameters of dip, bearing, diameter, length,
burden, spacing), properties of explosives, detonators,
primers and connectors, and Monte Carlo detonation timing
information.
The data from 2DBench can be further analysed in 2DView
(in section and oblique views) for contouring of holerelated data and energy distribution and in TimeHEx (blast
timing vs holes and explosives) for arrival times and
cumulative effect. 2DBench blasts and any related data can
be organized and viewed in JKBMS (Blast Management
System).
JKSimBlast
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Appearance

Appearance
1. title bar
stocks database, blast database, blast name / scenario
2. menus
display, selection, tools, options, shortcuts
>Edit – mode specific, >Tools – user definable
3. toolbars
design modes, mode tools, global tools, parameter
summary
4. design area
limitless window, scroll bars, view options
5. status bar
mode, action, cursor E/N, bearing & length (line,
anchor), view scale
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Design Modes
Design Modes
A blast is divided into five components, created in the
various modes in the program. Each mode has specific
tools and functions, plus there are several other tools for
global editing, query, input and output functions.

Area draw and edit lines and polygons (called
‘strings’), text labels
Drill drill and edit blast holes and nodes
Load insert decks – explosive and inert
Downhole insert down hole delays and boosters
Surface insert delays between holes and nodes
Detonation simulate detonation and analyse timing

General Features
General

Toolbar
Features
The first group of buttons on the toolbar are the blast
modes: Area (lines, polygons, labels), Drill, Load,
Downhole Delays, Surface Delays, and Detonation
Simulation. The next button is the global parameter dialog
– press this button in any mode to display the parameters
dialog for that mode. The remaining buttons are tools for
the selected mode tools and global tools. The last section is
a summary of the parameters in the selected mode.
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Cursor
The mouse can act as a pointer or cursor. To change to the
cursor, put the mouse over the Design Area and [click],
[Enter] or [spacebar]. To exit, [right-click] or [spacebar].
You can move the cursor with the mouse or the arrow keys.
Its position is shown by the coordinates on the status bar.
Selection Box / Mask
The selection box is a rectangular box; the selection mask
is a multi-sided shape. Either is enabled when the toolbar
button is “on”. The box and mask are used to mark holes
or zoom in on the viewing area. To set the selection box,
place the cursor for one corner of the box, then [drag] the
cursor to the position of the opposite corner. For the mask,
place the cursor and [drag] for the first side, then [click] for
each side – close by crossing the first side or [Esc].
Zoom
You can zoom in by pressing [Z] - zoom out by
[Shift]+[Z]. The screen will zoom to the box or mask if it
is active, otherwise zoom in or out will double or halve the
window scale. The scale is shown at the bottom of the
screen. [Double-click] the scale to activate a zoom control
box.
Blast Parameters
Blast parameters (hole and pattern dimensions, type and
amount of explosives and delays, etc) are entered via the
parameters dialog. Activate the dialog, enter the values,
click [Accept], and create the blast. Click [Save] to write
the parameters to an .ini file, and [Recall] to recall the
parameters. Click [Close] to close the parameters dialog.
Marking
Selective actions, such as load, copy or delete, are
performed on marked holes and nodes, shown by a small M
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in the centre of the hole. Mark or unmark holes via the
>Selection menu, [M] / [U] to mark / unmark the nearest
hole to the cursor, or [Ctrl]+[M] / [Ctrl]+[U] to mark /
unmark all holes. The number of marked and total holes is
shown in the summary bar (e.g. mh 45/50).
Query (information display)
[Click] the information display button at any time to see all
data for the current mode on the selected object (usually the
nearest to the cursor).
Help
Help is available from the >Help menu, or by clicking the
[Help] button on the dialogs.
Sample Blasts
Several sample blasts are included with the program in a
single 2DBench database, called samples.2db. These blasts
can be opened, viewed and modified in the program. The
sample database file is located in the data sub-folder,
typically in C:\Program Files\JKSimBlast\2DBench\data.
To open a sample blast, select >File >Open Blast… to
display the Open dialog. Click the [Browse] button, and
select the samples.2db file from the data folder. Then
select a blast from the [Name] list, and a scenario number
from the [Scenario] list if one is not selected automatically.
Click the [Open] button to open the blast in 2DBench.
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Tools & Keys

Tools & Keys
[click] = [Enter]
[click] or [Enter] or [space] = enter design area
[right-click] or [space] = exit design area
[right-click] = activate window, no other action
[R] Redraw = refresh screen
[Alt+Bksp] Undo = one step back
[click-click E/N] GoTo absolute, relative, polar, object
[Do Action]
use at any time
[Home] = move cursor to: nearest point on string, nearest
hole, nearest surface delay
[End] = centre all data (changes scale)
[Ctrl+End] = centre screen at cursor (does not change
scale)
= [anchor]

[right-click] or [space] to exit, [anchor]
OR place cursor, then [ ]

*

= [copy picture] set scale, window and view options
(also /File /Save Design Region Picture)
[Backspace] = delete nearest object: string, hole, top deck
in nearest hole, top D/H delay in nearest
hole, surface tie
[Delete] = select objects to delete: decks, D/H delays,
surface delays
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Creating a Blast Design
This tutorial will take you through the basic steps for Creating a
Blast Design
creating a blast design in 2DBench.
Generally, you create a blast by working through each of
the modes, represented by the first six buttons on the
toolbar, from left to right. In each mode, several specific
tools are available for creating objects on the screen or
analysing the data associated with the objects. In almost all
cases, the actions defined by the tools are implemented by
either [click] on the desired object, or anywhere in the
design area for global actions.
NOTE: global tools are available any time to assist in
placing objects
[anchor]
[hook]
[Home]
[End]
[scroll]
GoTo
[Z]

measure distance & bearing
lock the cursor to a line
lock on the nearest object
center all objects on screen
move the Design Area window
move the cursor to a position or object
zoom in
[Shift]+[Z] zoom out

Drilling Holes

[Click] the Hole Drilling mode button on the toolbar Drill Holes
(second from left).

There are several drilling methods: single hole, pattern,
polygon fill, follow line, and Baseline (from the Tools
menu). You can also place nodes (dummy holes) for
connecting surface delays where there is no blast hole. A
node is placed in the same manner as a single hole.
JKSimBlast
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For this example, you can use the default parameters to
drill holes or patterns; however, if you want to change
them, activate the parameters dialog, enter new values and
click [Accept New Values] then [Close].
Select pattern drilling.
Place the cursor on the left side of the screen for the
location of the first hole (row 1, hole 1) and [click].
Set the direction of the front row - move the cursor to
the right. The bearing of the row is shown on the status
bar. [Click] to set the direction.

Set the burden direction by moving the cursor below the
front row line and [click]. The blast pattern is created
on the screen. (The same technique can be used to set
the pattern from the back row – note the [Burden
Direction] in the parameters.)
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Press [End] to centre the blast on the screen.
Place the cursor near any hole in the pattern, and [click]
the query toolbar button [ ?] to show information on
the hole. Move the cursor to display a different hole.

Single holes and nodes can be placed anywhere in the
blast by placing the cursor and [click]. Nodes have the
same Bench Level as blast holes.
NOTE: by default, drilled holes are Unmarked and
imported holes are Marked.

Saving t he blas t

It is advisable to save the blast regularly. Blasts are saved Save the Blast
in a MS Access database. One database can hold multiple
blasts.
Select >File > Save Blast in the menu.
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Click [Browse] and select a folder for the blast database.
Enter a new file name for the database (e.g. “tutorial”) and
click [Open]. Click [Yes] to create a new database called
“tutorial.2db”. New databases are created from a template
database stored in the Templates folder.
Enter a name for the blast. Select a pre-defined scenario
number or accept –(new)- to automatically generate a
number (10 or higher).
Click [Save]. The name of the database file and the blast
will appear in the title bar at the top of the screen. The
blast name includes the scenario number.

Draw Lines and Polyg ons

Draw Lines
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This mode is for drawing lines and polygons and placing
point labels in the blast (collectively called strings). These
are mainly intended to “draw a picture” of the features
around the blast area, but can also be used to calculate
areas and volumes, to control hole placement for some
drilling methods, and in the calculation of some analyses.
In this step, draw a polygon around the blast pattern to
calculate the volume of the blast for the design factors after
the explosives have been loaded.
Open the Area parameters and set the Level to the same
as the Bench Level for the holes.
Select the polygon tool on the toolbar.
Place the cursor near one corner of the blast, and [click]
to start the polygon.
[Click] for each corner of the polygon, then cross over
the first side and [click] to close.
Save the blast >File >Save Blast, and select [Save] to
accept the blast name, then [Yes] to overwrite the
previously saved holes.

Loading Decks

Select Material Loading mode (third button). Materials are Load Decks
explosives and non-explosives.

Open the parameters dialog, and select a material – in
this case, an explosive. Click [Show Details] to see the
properties (note: non-explosives have VOD = 0).
Select a quantity method for the amount of explosive to
load, and enter an amount. For a deck loaded to x
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metres from the collar, select [Load to a Length From
the Collar] and enter the length below.
Click [Accept New Values]. [Close] the parameters
dialog if it is obstructing the blast.
Select [Load all holes] on the toolbar.
[Click] anywhere in the design area to load the type and
amount of explosive in all of the blast holes.

In the parameters dialog, select a stemming material and
amount ([Load to a Length From the Collar] and 0
metres), and [Accept…]. [Close] the parameters dialog.
[Click] again in the design area to load the stemming.
Click [ ?] on the toolbar to display details of the
nearest hole. [Click] on the hole again or [Page Up /
Page Down] to cycle through the charge details.
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>File >Save Blast and [Save].
holes.

[Yes] to overwrite the

Design Factors
Now that the explosives have been loaded, you can
calculate the design factors to check if the blast conforms
to the design objectives.
There are two methods used to calculate design factors.
The first method uses a polygon and the defined bench
height to calculate a volume for the blast, and the second
uses the blast hole parameters to calculate a volume for
each hole.
The bench height is initially defined as the difference
between the bench level and floor level, defined in the hole
parameters. The blast hole parameter method uses burden
and spacing and the vertical height of the blast hole, minus
subdrill, to calculate a volume for each hole.
In both cases, the total volume is multiplied by the defined
rock SG to calculate tonnage, and only marked holes are
used. The bench height and SG values can be changed
directly on the dialog.
First, mark all of the holes [Ctrl]+[M].
Select >Analysis >Design Factors or press [F].
[click-click] the Bench Height or Rock SG to change the
values.
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Downhole Delays

Downhole
Delays

Select Downhole Delay mode (fourth button). In this
mode, you insert delays, connectors and primers in the blast
holes.

Open the parameters dialog, and select a downhole
delay (e.g. #20 / 500ms), connector (tube) and primer
(any). Click [Show Details] to see the properties.
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On the [Delay] tab, enter a distance from the collar or
the toe for the delay – the depth must be set so that the
delay is in the explosive deck (e.g. 1 m from toe).
Click [Accept] and [Close] the parameters dialog.
Select [ALL holes] on the toolbar.
[Click] anywhere in the design area to load the delays in
all of the blast holes. You should see a coloured
triangle inside each hole.
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Click [ ?] on the toolbar to query any hole.
>File >Save Blast and [Save]. [Yes] to overwrite the holes
and decks.

Surface Delays

Surface
Delays

Select Surface Delay mode (fifth button). In this mode,
you insert delays and connectors between the blast holes.

For this sample blast, tie a simple pattern along the rows
with a single centre line between the rows.
First, mark all of the holes. In this mode, mark the
holes via the Selection menu, or [Ctrl]+[M] with the
cursor inactive.
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Open the parameters dialog, and select a detonator and
appropriate connector (e.g delay: 17ms; connector: 17).
Click [Show Details] to see the properties.

Select bi-directional (for this blast): typically, shocktube detonators are uni-directional; cord detonators are
bi-directional. With bi-directional mode, it does not
matter which direction the delays are placed in the blast.
Select Inter-Hole for the delay type (this option allows
inter-hole and inter-row delays to be displayed
separately – it does not affect their performance).
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[Accept] the values, and close the dialog.
Select [Multiple hole tie up].
marked for this method.

The holes must be

Place the cursor on the first hole in the front row, and
[click].
Move the cursor slightly past the last hole in the row.
Note the highlighted holes will be connected. [Click]
again to connect all of the marked holes with inter-hole
delays.
[Esc] to disconnect from the last hole (or [click] with
the cursor on the hole).

Repeat for the other rows.
If you make a mistake, place the cursor near a surface
delay and press [Backspace], or mark the relevant holes
and select >Edit >Delete…
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Open the parameters dialog and select an inter-row
delay and connector (e.g. 42ms). Select Inter-Row for
the delay type. [Accept] and [Close] the dialog.
Select [Hole to Hole delay tie up].
Place the cursor on a hole near the middle of the front
row and [click].
Place the cursor on a hole in the second row, and [click]
again to connect the rows.
Repeat for the third row and so on. [Esc] or [click] on
the last hole to disconnect.
Click [ ?] on the toolbar to see the details for a delay.

>File >Save Blast and [Save] – [Yes].
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Detonatio n Si mula tion

Detonation
Simulation

Select Detonation Simulation mode (sixth button). In this
mode, you run the detonation simulation and calculate
times for all objects in the blast.

You can open the parameters dialog if you wish and
modify any of the values, but the default values will work
fine for this example.
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To run the simulation, place the cursor over the middle
hole in the first row (where the inter-row delay is
connected) and [click]. You will see the surface delays
initiating, and then each hole detonating.
While the simulation is running…
[S] = stop
[any key] = step
[C] = continue
[Esc] = end
To slow the simulation, enter a pause value in the
parameters. Click [ ?] on the toolbar to query a hole.
[Click] anywhere in the Design Areato run the
simulation again from the initiation hole, or select
to run the simulation from the nearest hole to the cursor.

>File >Save Blast and [Save] – [Yes] to save the
detonation times with the blast.
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Bas ic Analys es

Basic
Analyses

Click

to display the first detonation contours.

Click
to show a chart of maximum instantaneous
charges (kg per 8ms delay, initial setting).
to change the window time and X-axis values;
and then a bar to show the linked holes for that bar;
use the arrow keys to “scroll” through the chart.
to enter the values for the scaled-distance function;
to display the PPV values for a selected bar.
To display the detonation times, select >View >Display
Options, then [Visibility] – [Downhole Detonation Delay
Labels] and [Apply].
Select >Analysis >Blast Summary for totals, counts and
averages of drilling, charging and delays used in the blast.
The details from these forms can be copied to the clipboard
and pasted into almost any application that can accept text.
Select >File >Print Blast Window to print the blast plan,
and set the display via >View >Display Options.
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General Functions
2DRing incorporates a number of different functions to
facilitate the design and analysis of underground blasting:
Core Design Functions include grid size and grid
orientation settings, definition of areas with strings
functions, drilling mode functions, charging mode
functions, tie up functions and detonation simulation.
Editing Functions include the selection of objects (eg.
marking functions), deleting objects (eg. holes, charge
etc.), deleting strings, changing the attributes of objects
(eg. visibility, colour etc.).
Viewing functions include zoom in and out, specify
zoom, go to position, centre design, redraw and query
functions.
The reporting functions include printer set up, print
the design window and turning object text on/off for
printing more information.
Data organisation functions include Microsoft Access
database storage plus general importation and
exportation facilities.
Design Area
Screen Layout
Figure 1.1 shows the screen layout of the main design area
of 2DRing. The window consists of a drawing area, title
bar (which has some status information), menu bar, tool
bar, status bar and scroll bar.
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This main window or drawing area is a section view of a
3D world defined by grid coordinates (ie. Easting, Northing
and Reduced Level (RL) in metres).
The menu bar contains all the functions available in
2DRing and it is divided into six items (ie. File, Edit,
Mode, Parameters, View, Marking and Help).
The tool bar consists of four items, the major design mode
buttons which are associated with mode functions in the
main menu bar; the parameters setting button which allow
the user to set the properties of a design mode (ie. drilling,
loading etc); the construction mode buttons which give the
user some construction options available for design and the
information mode buttons which allow the user to query a
design.
The status bar gives the user an indication of the current
design mode and construction option as well as design
properties such as current location, current construction
line properties, current anchor line properties and current
scale for the drawing.
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Title Bar
Menu Bar
Parameter Information Bar
Tool Bar
Major Mode
Buttons

Parameters
Button

Construction
Mode Buttons

Information
Mode Buttons

Current coordinates
Scroll Bar

Drawing Area

Selection Box

Status Bar
Scale

Figure 1.1 General Layout of the Main Design Window

Design Area Appearance
The first step in any design is to define the characteristics
or appearance of the area in which a design is to be created
(ie. Setting mine coordinates, global coordinates, grid size,
grid orientation etc.). A number of tools are available in
2DRing for this purpose and these are accessed via the
View+Options…menu item (see Figure 1.2 )
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Figure 1.2 Change options dialog

The Change options dialog allows the user to set up and
modify the drawing area in which a design is to be created.
This dialog contains nine options describing different
aspects of the design layout as outlined in Table 1.1 .
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Table 1.1

Option
Grid
Dimensions
Grid Line
Grid
Annotate
Visibility
Colour
Text
Size
Selection
Other

Change options dialog description
Description
Activates the Grid and defines the size of
grid intervals; East/West and North/South.
Selects the appearance of the grid lines
Option for defining grid text
Selects object type to make visible or
invisible
Selects the colour of the object type
Selects where object text is positioned in the
design layout
Adjusts some text sizes by a percentage
Selection box and mask properties
Axis indicator properties

The Text position option contains dialog boxes which
allow the user to interactively select and position text
around an object as shown in Figure 1.3. Note that the text
will not appear until the relevant object visibility is turned
on.
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Figure 1.3 Text position dialog and options
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The Object colour option allows the user to change the
colour of all objects in the design layout. The standard
colour palette dialog is shown in Figure 1.4.

Figure 1.4 Colour palette dialog

Settings can be stored by the user in initialisation files (ie.
*.ini files). To do this the user must access the save
parameters dialog via the Parameters+save parameters
as.. menu item as shown in Figure 1.5 . The user can recall
these *ini files whenever they are needed from the same
menu item.
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Figure 1.5 Saving design layout parameters
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Global Construction Tools
Selection Box
The selection box allows the user to quickly select a square
or rectangular region within the design area. It is toggled
(ie. turned on/off) by clicking on the selection box icon in
the tool bar.

Selection
Box
On/off

Selection mask
The selection mask allows the user to select irregular
regions (ie. polygons of up to 10 vertices) within the design
area. It is toggled (ie. turned on/off) by clicking on the
selection mask icon in the tool bar or alternatively by
accessing the options dialog via the View menu item.

Selection
Mask
On/off

Goto Position
The “Move 2D cursor to location” dialog (Figure 1.6) is
activated via the View menu item (Ctrl+G). The position
dialog allows the user to move the 2D cursor to a specific
grid position. The user may move the 2D cursor to an
absolute coordinate or to a position relative to the 2D
cursor's current position. The relative move can be in
Cartesian coordinates (eg. Easting, Northing and RL) or in
spherical coordinates (eg. Angular move). To move to a
location, click on the “Move cursor” button.
The “Move 2D cursor to location” dialog also allows the
user to carry out a design action at a specific location by
clicking on the “do Action” button.
Note that if a ring plane has been selected, then the chosen
coordinate will be forced onto this ring plane.
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Figure 1.6 Move 2D cursor to location Dialog

Anchor

Anchor
The Anchor is a measuring tool that allows the user to
obtain bearings and distances from a start point to an end
point. It is toggled by clicking on the Anchor icon in the
tool bar.
Specify Zoom
This option is accessed via the View menu item. The new
scale dialog is activated and it is shown in Figure 1.7. The
user may change the scale and click on the apply button for
the change to take place.

Figure 1.7 New scale option dialog
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The user may also change the current scale by double
clicking the scale shown in the status bar (see Figure 1.1).
Zoom in, Zoom Out, Previous Zoom
These options are also accessed via the View menu item
(eg. View+Zoom in... ). The default value for both zooming
in and out is “twice” of the current scale. (eg for a scale
1:750 ; 1:(750/2) for zooming in and 1:(750x2) for
zooming out).
If the selection or masking box is on, then the zoom in
option will automatically zoom into the selected region.
The user may also quickly zoom in and out of a region by
using the shortcut keys “Z” , “Shift+Z”. The previous
zoom state can be selected with "Ctrl+Z".
Centre Design, Select Nearest Object
The centre design option is used to automatically centre on
the screen all the objects of a design.. This option is
accessed via the View menu item or by pressing the [end]
Key. Similarly to move the cursor to the nearest object,
depending on the current mode (ie. string, hole, deck etc.)
the user must press the [Home] key or access this option
via the View menu item.
View Define
The user is able to view the design from different directions
by activating the choose view direction dialog (Figure 1.8)
via the View+define menu item. This dialog allows the user
to flick through several pre-defined views.
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Figure 1.8 New scale option dialog

Hole Marking
Applying changes to holes can be easily done with 2DRing
editing functions. For changes to occur, holes should be
marked. To mark holes, a number of options are available
in the Marking menu item:
Marked holes are highlighted (see Figure 1.9 below)
Note
The hole nearest to the 2D cursor can be individually
marked or unmarked by pressing the “M” and “U”
keystroke buttons respectively. Holes within a trim or
selection box can be marked with Ctrl+M and unmarked
with Ctrl+U.
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Figure 1.9 View of marked and unmarked holes

Redraw
Redraw is used to update the current screen. This option is
accessed via the View menu item or by pressing [R].
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Query Options
Design information functions are included in 2DRing,
allowing the user to check the properties and components
of a design (eg. hole lengths, hole diameters, explosive
charges, in-hole delays, etc).

Information
mode

Object Query
The individual object query function is activated by
clicking on the Information mode icon in the tool bar.
This option allows the user to obtain information about the
design for the different design modes available (eg. holes,
decks, in-hole delays, surface delays etc.). The user should
be in the appropriate mode.
A typical information box is shown in Figure 1.10 & 1.11.
In this case the user is inquiring about drill hole
information of a particular design. As well as charge
information of a particular hole.
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Figure 1.10 Design Information dialog
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Figure 1.11 Design Information dialog

Note
For multiple decks or in-hole delays in a hole, clicking the
left mouse button will cycle through the individual items
in the hole.

98

JKSimBlast

2DRing

Loading & Saving
Designs can be loaded and saved via the File menu item..
The corresponding dialog boxes are shown in Figures 1.12
and 1.13.

Figure 1.12 Open Design Dialog

Figure 1.13 Save Design and more information dialog
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Note that 2DRing assigns the extension of *.2dr for the
Microsoft access database files. This does not mean that the
user cannot use the default *.mdb extension.
When Saving a project, the overall design name and the
names of the relevant design components should be
specified (Note: by pressing enter after entering the overall
design name, the relevant design information names are
automatically added to the appropriate tables).
It is important to note that if no names are specified to the
relevant design information combo boxes (ie. Area design
name, Hole design name etc.) then that information will not
be saved.
The user may also specify different blasting scenarios for
the same overall design by choosing the item labelled
“new” before saving. The more information button (Figure
1.12) allows the user to insert extra information about the
overall design and individual blasting scenarios.
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Importing and Exporting
2DRing currently allows the user to import string
information via a generic importer of text files (ie. ASCII
file importer).
Importing String Information
To import string information, the user should access the
general string import option via the file menu item (File +
General string import). The select string file to import
dialog box is activated (Figure 1.14). The user must select
the ASCII file to be imported.

Figure 1.14 Sting file selection dialog

Once the file has been chosen, the import data dialog box is
activated showing the ASCII file information (Figure 1.15).
At this point the user should select the number of comment
lines and how columns are separated. The number of
comment lines can be chosen in two ways. The first is to
type a number in to the appropriate text box (# Comment
lines), or by clicking in the last comment line in the file
preview box and then clicking on the button next to the
#Comment Lines text.
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Figure 1.15 Import data dialog box

Press the Next button for the data definition screen (Figure
1.16), to specify the appropriate column names (eg. String
ID No, Easting, Northing etc..)

Figure 1.16 Import Strings - Data Definition Dialog
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The user should also specify the choice of string in the data
definition dialog box (Figure 1.17). That is, define whether
strings are defined by common values in a column, strings
are defined per line or whether the file has only one
string).

Figure 1.17 Import Strings - Data Definition Dialog

The next step is to define whether the strings are open or
closed by clicking the button How are strings closed ? …
The String closure definition dialog box is activated
(Figure 1.18). In this dialog box the user must choose
between four definition criteria :
All strings are closed if the number of points > 2
All strings are open
Strings are closed if the first and last point are within
an certain specified tolerance
Manually specify closed strings
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Figure 1.18 String closure definition dialog

The next step is to access the data exclusion list dialog
(Figure 1.19) by clicking on the edit exclusion button. In
this dialog the user is able to exclude information from the
ASCII file to be imported. There are some cases where
extra information is added to data files which is not directly
related to string coordinate information. This step is used to
filter out that type of information.

Figure 1.19 Data exclusion list dialog
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Once the appropriate information is selected via the import
strings data definition dialog; the next and final step is to
select some string properties in the final dialog box (Figure
1.20). This is to specify information that is missing in the
ASCII file but is needed by 2DRing. The user can also do a
conversion of coordinates to metres from other units such
as feet etc.

Figure 1.20 Final string information dialog

Finally all of the above import configuration can be saved
so that strings can be quickly imported without following
all of the above steps. (Figure 1.21)

Figure 1.21 Saving import configuration
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The configuration for a particular ASCII file extension is
saved in the Import.ini file. The comment can be used to
recall the source of a particular file extension
Exporting Data
2DRing allows designs to be exported to 3X3Win for more
detailed analysis in 3D. This is done via the File+Export
menu item which activates the File Export dialog shown in
Figure 1.22.
Note that 3x3Win project (*.prj) file extension is the
default export file type for analysis in 3x3Win.

Figure 1.22 Export data dialog

Other options include the exportation of design summary
text files, including:
A drilling report
A loading report
Downhole delay summary report
Surface delay summary report
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The above reports are column format, space/tab delimited
text files which can be opened and saved with other
applications (ie. excel, word, notepad etc.). The user must
mark the drill holes to be included in the report file before
accessing the export file option.
Figure 1.23 shows an example of a drilling report text file
summary opened with excel.

Figure 1.23 Drilling report text file opened with MS Excel
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Reporting
Printing
The design can be printed as shown on the screen, at the set
scale, including any visible view options such as hole
numbering or in-hole delays. Print design options and
printer properties must be chosen before printing.
The Print design window is accessed via the File menu
item (File +Print Design window..). The print design dialog
is shown in Figure 1.24 below.

Figure 1.24 Print design dialog

The user must select the printer from the list available.
Margins can be set for the design page (these are in
addition to the unprintable area around the edges of the
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paper). A logo and a comment box can be printed in any of
the corners of the page. The logo is a bitmap file
(Printlogo.bmp) in the Auxfiles folder. This file can be
replaced with any bitmap file. The comment box can
contain any text information, such as the blast name or the
designer's name, scale, etc.
The configuration for a printer can be saved. Click the save
button, and then enter a descriptive name for the
configuration.. Click OK to save the configuration. An
existing set up can be recalled from the list of available
configurations on the Print Design dialog (Figure 1.25).
All printer configurations are saved in the file
2DBPrnConfigs.ini in the 2DRing folder. Different sets of
options can be created for the same printer or different
printers and stored in the file for later use.

Figure 1.25 Save Printer Configuration dialog

A print preview can also be obtained by clicking on the
preview button (See Figure 1.26).
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Figure 1.26 Print preview
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Design Input
Within 2DRing, the creation of a design follows a
systematic engineering approach, which can be divided into
the following steps:
Definition and selection of ring planes
Definition and location of regions to be blasted (stope
outlines), drilling drives and drill positions.
Blast hole drilling.
Selection and loading of explosives.
Selection and loading of accessories (delay
detonators, primers, down-hole and surface
sequence)
Definition and Selection of Ring Planes
Before the definition of blasting regions (ie. stope outlines),
drilling drives, drill positions and drill holes, the user must
create and select the "ring plane" where all these objects
will reside. In 2Dring, a ring plane can be defined as the
top of the hierarchy of design objects.
To create ring planes the user must go to the
Parameters+Select Ring planes menu item or
alternatively by pressing on the ring planes/drives/drill
positions design mode icon and then in the parameters icon
(see left).
The "select ring plane for design" dialog is then activated
(see Figure 2.1). This dialog box displays the list of ring
planes in the current design, the user may select any of
these to create drill drives and position blast holes. As
shown in Figure 2.1, two default ring planes are available.
JKSimBlast
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As an example, the first is a plane with the origin at (0,0,0)
with a bearing of 180o and a dip of 0o. The bearing value
corresponds to the bearing angle normal to the plane, for
instance, plane A is a plane running E-W with the normal
to this plane along the N-S direction.

Figure 2.1 Hole drilling dialog

The user may also add new planes or edit current ones by
pressing the [edit ring planes] button . The Edit ring planes
dialog is activated (Figure 2.2). The user is then able to
create a new ring plane by assigning a new label and
specifying the appropriate orientation properties of this
plane. After assigning properties to a plane the user must
press the [Add new ring plane] button, to create the new
ring plane. Current ring planes with no objects attached can
also be modified by pressing the [Modify selected Ring
Plane] button.
Another useful feature involves the creation of ring planes
from existing string information. This is particularly
helpful when string sections from an external mine
planning software are imported into 2DRing for design. To
create a ring plane from existing string information the user
must press the button labelled [Assign Ring Data Using
Existing String], then the assign ring properties dialog is
activated (Figure 2.3). Here the user may choose the string
from which ring plane properties are going to be assigned.
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Figure 2.2 Edit ring planes dialog

Figure 2.3 Assign ring properties dialog

Once the user has selected the string, using either of the
methods shown in Figure 2.3, the orientation properties of
this string are automatically added to the "edit ring planes"
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dialog (Figure 2.2). The new plane can then be created by
clicking the "add new ring plane" button.
Definition of Boundaries
2DRing allows the user to create blast design region or
boundaries with a number of simple CAD functions. The
procedure for defining this geometry includes both the
importation of string geometry from other applications (see
Chapter 1) and the creation of string lines and string
polygons. Text labels can also be used to identify regions in
the overall design area.

Area Mode

String Line and Polygon Creation
The boundaries of a drilling drive or the outline of a
particular stope can be created in Area mode. This option is
accessed via the Mode+Area menu item or alternatively by
clicking on the Area Mode Icon.
The area mode function allows the user to create a string
outline. A string is a collection of two or more points
joined together by lines. Strings may either be opened or
closed (polygon). A closed string is defined as starting and
ending at a common point.
There are two ways of creating a string outline to define the
geometry of the area to be blasted, namely:

Single
Line Mode

Single line segment drawing: This method allows the
user to draw single line segments to define a single line
or a polygon. This option is activated by clicking on the
single line mode icon.
To draw a line, place the cursor at the position of the start
of the line, click the mouse or press [enter], move the
cursor to the position of the end of the line and click again
or press [enter].
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Multiple line segment drawing: This method allows
the user to draw polygons by joining multiple line
segments. It is activated by clicking on the multiple line
mode icon.

Multiple
Line Mode

To draw a polygon, place the cursor at the position of the
start of the first side (the first point), click the mouse or
press [enter], move the cursor to the position of the end of
the side (next point) and click again or press [enter]. Repeat
this for each succeeding point, and close the polygon by
crossing any drawn side.

Figure 2.4 String
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Note
In line and polygon creation mode, 3D and 2D coordinates
and line creation properties are displayed on the screen as
shown in Figure 2.4.
To stop the line creation, press the Esc Key or if a closed
polygon needs to be created, then cross any of the earlier
line segments with the new one..
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Drill Drives and Drill positions
Drill Drives
Drilling drives can be created from existing closed string
polygons and/or can be individually created from predefined standard tunnel profiles.
To create a drive from an existing polygon, the user must
activate the "ring planes/drives/drill positions" mode icon
and click on the make drive outline icon. The user must
click on the nearest polygon for it to be used as a drilling
drive. The created drive outline also becomes a new closed
polygon.
As mentioned above, single drill drives can also be created
and positioned anywhere by clicking on the make drive
outline icon. The make drive outline dialog is then
activated (Figure 2.5 ).
The make drive outline dialog allows the user to specify
the dimensions of the new drive, the heading and its profile
or shape. The Grade/Centre line intersection defines the
origin for the points along the string to be created and how
far the left wall and floor is to be from this point. The
origin specified will be forced onto the current ring plane
automatically.

Ring
Planes /
Drives /
Drill
Positions

Make
drive
outline
from
closed
polygon

Make
drive
outline

The numbers in the shoulder style option labelled height
and radius are relevant to the bezier line method and the
rounded shoulder method respectively (Figure 2.6a &
2.6c). The circle section takes the circle radius as being half
the new drive width.
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Assign current ring plane
bearing and dip to the
heading

Assign cursor easting
Assign cursor northing
Assign cursor level
Assign half drive width
Assign half drive height

Figure 2.5 Make drive outline dialog

The bezier line option will produce an arch with a height
given by the dimension (Ah) while the rounded shoulder
option uses the dimension as a radius and tries to fit a
quarter circle section of the given radius (Ar) at the
shoulders. If the radius for the shoulder circles is greater
than half the Drive width then one circle of the given radius
will be fitted at the top.
Figures 2.6 shows examples of the various arch types
possible. In all these figures the Height(H) is 4m and the
Width(W) is 4 metres. Figure 2.6a, Ah = 1m, Figure 2.6b:
Ar = W/2 = 2m, Figure 2.6c: Ar = 1m and Figure 2.6d: Ar =
3m.
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a) Ah = 1

b) Ar = W/2

c) Ar < W/2

d) Ar > W/2

Figure 2.6 (a ,b, c & d). Various arch types possible

Drill Positions
Drill positions can be inserted into drilling drives by
activating the "ring planes/drives/drill positions" mode icon
described in section 2.3.1 and clicking the create drill
position inside drive icon. The user then must select a
location inside the drive and click the left mouse button or
press [enter] to define the drill position.

JKSimBlast
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Drilling
Mode

Blast Hole Drilling
The creation and positioning of blast holes is carried out by
accessing the drilling mode function available in the
Mode+drill menu item or alternatively by clicking on the
drilling mode icon.

Current
mode
parameter

Before drilling begins, hole properties must be
appropriately defined. This is done by accessing the hole
drilling dialog shown in Figure 2.7. To activate this dialog
the user must go to the Parameters+drilling menu item or
alternatively must click on the parameters icon.

Figure 2.7 Hole drilling dialog

The hole drilling dialog enables the user to input all
properties attached to drill holes including diameter, stand
off distance from a defined boundary, cost information,
maximum length and angle in current plane.
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Individual holes can be positioned using the single hole
construction mode which is activated by clicking on the
single mode icon in the tool bar. Holes can be drilled by
selecting a drill position to define the start of a hole (collar)
and moving the cursor to the end position to define the toe
of a hole.

Drilling
Mode

Note
A drill position will be created automatically if one does
not exist within a tolerance value that can be user specified.
Tolerances can be adjusted via the View+tolerances.. menu
item
Holes can also be drilled to a specified boundary (ie. stope
outline ) by clicking on the drilling to boundary icon. The
user must select the required drill position then click on the
string outline to define the boundary that the drill hole must
reach. Once these to objects are selected, the drilling action
can continue normally.

Drilling to
boundary

Note that a dash line indicates the boundary to which a hole
will be drilled. The user can drilled at a defined distance
from the selected boundary by assigning a stand-off
distance value in the Hole drilling dialog. Figure 2.8 shows
an example of the option available to drill to a boundary.
In this case a stand off distance of 0.3m has been defined.
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Select drill position,
then select boundary

Figure 2.8 Drilling to boundary

122

JKSimBlast

2DRing

Selection and Loading of Explosives
The charging of blast holes is carried out with the loading
mode function. This function is activated via the
Mode+load menu item or alternatively by clicking on the
loading mode icon.
Before holes are charged, the user must select the type of
explosive to be used. This is done by accessing the loading
decks dialog (Figure 2.9) via the Parameters+Loading
menu item or alternatively by clicking on the current mode
parameter icon. This dialog also allows the user to edit
some of the explosive properties as well as charging
characteristics.

Loading
Mode

Current
Mode
Parameter

Figure 2.9 Loading decks dialog

Explosive types and properties are stored in a standard
Microsoft database file with a default name of Stock.mdb.
This file can be accessed and modified with the use of
Microsoft Access Database Software.
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Single hole

The loading mode allows the user to load one hole at a
time, all holes at once, a group of marked holes or a group
of unmarked holes. These options can be accessed via the
loading mode icon selection in the tool bar and shown
below:

All holes

For single hole loading the user must click the mouse
button on the nearest drill hole to be charged and for all
other options, the user must click on the design window.

Marked
holes

As shown in Figure 2.10, options for loading quantity
include: length of charge, length from the collar, mass in
kg, % of hole length and load to nearest point to cursor.

Unmarked
holes

Figure 2.10 Loading quantity options
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Selection and Loading of Delay Detonators
2DRing uses both in-hole and surface delays to design the
initiation sequence of explosive charges.
Downhole Delays
The placement of downhole delays is carried out by
activating the downhole delay mode function via the
Mode+downhole delay menu item or alternatively by
clicking on the downhole delay mode icon.
Before holes are primed and down-hole delays inserted, it
is essential to select the type of delay element, connector
and primer to be used. This is done by accessing the
downhole delays dialog (Figure 2.9) via the
Parameters+downhole delays menu item or alternatively
by clicking on the current mode parameter icon.

DownHole delay
mode

Current
mode
parameter

Single hole

All holes

Marked
holes

Unmarked
holes
Figure 2.9 Downhole delays dialog
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The downhole delays dialog also allows the user to edit
some of the delay connector and primer properties assigned
to a particular design.
The downhole delay mode allows the user to insert
downhole delays one hole at a time, all holes at once, a
group of marked holes or a group of unmarked holes. These
options can be accessed via the downhole delay mode icon
selection in the tool bar.

Surface
delay
mode

Current
mode
parameter

Surface Delays
Once holes are primed and downhole delays inserted, the
next step is to place surface ties between hole collars. The
placement of surface ties is carried out by activating the
surface delay mode function via the Mode+surface delay
menu item or alternatively by clicking on the surface delay
mode icon.
Before tying begins, the user must select the type of surface
delay element and the type of connection to be used. This is
done by accessing the surface delay dialog (Figure 2.10)
via the Parameters+surface delays menu item or
alternatively by clicking on the current mode parameter
icon.
Depending on position, surface delays are referred to as
inter-row ties or inter-hole ties, in addition the connection
of each surface delay can be specified to be bi-directional
or uni-directional (Figure 2.10).
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The surface delay mode allows the user to tie up the design
hole to hole or by multiple holes. These options can be
accessed via the surface delay mode icon selection in the
tool bar.

Hole by
hole tie

Multiple
Tie-up

Figure 2.10 Surface delays dialog

Surface ties can also be connected to nodes, which can be
used as ignition points or help on the positioning of ties.
Nodes can be added to a pattern by activating the drilling
mode function and the create node icon. The user can then
click in the position where a node is required.

Create
node

Delay accessories are stored in a standard Microsoft
database file with a default name of Stocks.stk. This file
can be accessed and modified with the use of Microsoft
Access Database Software or with the use of JKMRC
Stockview module
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Engineering Tools and Analysis
A number of engineering tools have been incorporated to
the software to facilitate the analysis and continuous
improvement of ring designs, namely:
Detonation simulation
Explosive energy distribution
Fragmentation

Detonation
mode

Current
mode
parameter

Detonation Simulation
Simulation of the blast detonation sequence can be carried
out in 2DRing and allows the user to visualise and report
the detonation sequence. This function is activated via the
Mode+detonate menu option or by clicking on the
detonation mode Icon.
The characteristics of the simulation can be established in
the detonation simulation dialog (Figure 3.1), which is
activated via the Parameters+detonation simulation
menu item or alternatively by clicking on the current
mode parameter icon.
In the detonation simulation dialog the user may define
characteristics such as: pausing between events, showing
events in a time frame, showing all events, apply delay
scatter factors, set up the time step of a simulation and run
Monte Carlo simulations of the detonation sequence.
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Figure 3.1 Detonation simulation dialog

A simulation can begin by assigning the position of the
ignition point. This point can be chosen and changed by
activating the “start detonation from nearest hole” icon..
If the user wishes to re-initiate the blast from the current
position then the “current ignition point” icon should be
used.

Start
detonation
from
nearest
hole/node

Start from
current
initiation
point
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Explosive Energy Distribution
2DRing incorporates two methods for calculating and
displaying the distribution of energy of explosives in 3D
space.
3D static explosive energy distribution
4D dynamic explosive energy distribution.
Explosive energy distribution may be expressed in several
units: kg/tonne, kg/m3, MJ/tonne, MJ/m3 and MJ/m2. The
first four unit types (excluding MJ/m2) available in the
explosive distribution model are analogous to the
conventional powder factor calculation (kg of explosive
divided by tonnes or volume of rock blasted), the fifth unit
is an Energy Flux value.
Static 3-D Explosive Distribution
The three dimensional explosive energy distribution of a
charge does not take timing into account and is determined
in 2DRing following the approached developed by Kleine
et al (1993).
The traditional powder factor calculation was extended by
considering a small infinitesimal segment of charge and
writing the equation for the resulting explosive
concentration at a point “P” for a sphere centred at the
charge segment, the general form of the equation is as
follows, (also refer to Figure 3.2).
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Equation (6) can be integrated and rewritten as:
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-L1

P

h
r

l

L2
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Figure 3.2 3D Explosive Energy Concentration at point P

Note
Special conditions apply to the above relationships at the
charge axis (ie. h=0) and at very large distances (ie.
h
). The explosive concentration at any point in 3D is
determined by solving the appropriate integrated form of
the equation for each explosive charge and summing the
values.
Dynamic 4-D Explosive Distribution
The 4D explosive energy distribution differs from a 3D
calculation, in that the detonation timing is considered as
the fourth dimension. The model is based in the 3D
JKSimBlast
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analysis and incorporates a weighting factor which is a
function of the time a deck detonates and a rock mass
specific factor called "cooperation time".
As part of the 4D energy distribution analysis, a timing
simulation must be carried out first. The 4D energy
distribution tessellates points on a plane specified by the
user just like the 3D energy distribution. For each
calculation point, the nearest charged deck is found. The
time at which this deck detonates is used as a reference
time (tnd ). A weighting function is determined based on
the cooperation time and detonation time of charges. For
every explosive deck in the timing simulation the 3D
explosive energy value is calculated and multiplied by the
term given by the following weighting function:

e

td tnd
tc

where td is the time the deck detonated, tnd is the time the
nearest deck to the calculation point detonated and tc is the
co-operation time. The graph of this weighting function is
shown in Figure 3.3.
The cooperation time affects how steeply the weighting
goes to zero and is the time interval within which decks
adjacent to a detonating deck will assist in the
fragmentation of the rock mass. After this time interval, the
interaction of decks reduces significantly due to the
movement of the rock mass. The time is approximately the
time to first burden movement and is very much a rock
mass dependent property.
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Weighting

1

time
Time of reference
deck detonating

Figure 3.2 Weighting function of 4D energy distribution

Calculation of Explosive Distribution.
To calculate or display the explosive distribution of a
particular section of a pattern, the user must perform the
following steps:
1. Define the calculation region using the trim box tool
2. Access the explosive energy distribution dialog vie the
tools menu (ie. Tools + Explosive Energy
Distribution…).
3. In the dialog box, create a new file or open an existing
one to store the information (see Figure 3.3)
4. Define calculation parameters such as grid resolution,
rock SG, and the location of the calculation plane along
the excavation heading.
5. Define the holes that will be included in the calculation
(ie. marked, unmarked)
6. Select type of calculation (ie. 3D or 4D) and click on
calculate new data.
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Click here to create
new binary file to store
calculation information or
select existing an file
Load existing data
Calculation inputs
1. Grid resolution
2. Rock specific gravity
3. Plane distance along
drive heading

Type of analysis

Figure 3.3 Explosive energy distribution dialog

Note
Changes can be made to the explosive energy concentration
scale by clicking on the display tab (see Figure 3.3). The
following options are included in this dialog:
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o

Change scale range and units

o

Change scale colours

o

Redisplay current file

o

Other displaying options such as drawing contours as
filled rectangles or pixel points and drawing holes after
contouring
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Figure 3.4 shows the 3D explosive energy distribution for a
9 hole underground ring design with 102mm diameter
holes charged with ANFO. Deck lengths are shown in
black.
The input parameters used for this calculation included:
A grid resolution of 0.1m
A rock S.G. of 2.75
A calculation plane at a burden of 2.5m

Figure 3.4 3D explosive energy calculation

Figure 3.5 shows the 4D explosive energy distribution for
the above ring. The assumed input parameters used in this
calculation were:
A grid resolution of 0.1m
A rock S.G. of 2.75
A calculation plane at a burden of 2.5m
JKSimBlast
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Inter-hole timing of 25ms
Cooperation time 30ms

Figure 3.5 Example 4D explosive energy calculation in 2DRing
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Fragmentation
A review of breakage and fragmentation literature has
shown that only a few models have been specifically
developed for applications in underground production
blasting.
These approaches, however, have applied
empirical relations that do not adequately consider ring
blasting geometries, have failed to appropriately respond to
changes in basic design input parameters, and have
complex input and calibration requirements. This justified
the development of an alternative modelling framework to
specifically address the prediction of fragmentation in
underground production blasting.
The new model,
designated as FragmentO, has been included in 2DRing.
The basis of FragmentO is a “single ring” deterministic
model which can be extended into a stochastic model to
simulate the impact of external operational factors on
fragmentation. The single-ring component mechanistically
models the extent of both near field and mid to far field
fracture zones to predict the distribution of rock fragments
expected to report to drawpoints. FragmentO can be used
at the evaluation stage of blast design in an operating mine
and for studies at the conceptual, pre-feasibility and
feasibility stages of a project, where different drill and blast
scenarios and associated costs are assessed.
For a given drilled and charged ring, activate the selection
mask and define the blasting area or boundary region
bounded by the drilled and charged blastholes
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From the Tools+Fragmentation Model… menu item,
activate the fragmentation model dialog. This main dialog
contains four major tabs which help the user manage all
key input parameters and final output.
In the Control tab the user sets the basic calculation
requirements of the model:
The calculation grid resolution sets the resolution of the
PPV point calculation at a distance in 3D space. The
value of 0.1 m is adequate and should be maintained in
most underground production blasting conditions. It
should be noted that finer resolutions will increase
calculation times.
Start burden, Burden increment and End burden allow
the user to set a range of burden configurations to
evaluate fragmentation outcomes.
The critical S/B ratio is a simple empirical threshold
which is used by the program to highlight the final
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selection of fragmentation results given in the Model Tab
(see Model Tab description).
Option to invoke a smoothing algorithm for the
fragmentation curves output by the program and
activated in the Model tab.

In the Rock Properties tab, the user sets the rock input
parameters required by the model.
The first set of rock input parameters are the
Holmberg/Persson attenuation constants K, ~ and the
PPV onset of breakage. The default parameters given
have been shown to adequately represent metalliferous
hard rock conditions.
Rock material strength parameters are also specified
here, they include Rock SG, UCS, Tensile strength, P-
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wave velocity,
Poisson’s ratio.
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In the Rock Structure tab, the user sets the parameter that
best describes the rock mass fracturing conditions local to
the ring volume. This is defined by an estimate of the
average size of in situ blocks.

In the Model tab, the user is able to activate modelling
calculations and obtain a list of output for each burden
configuration set in the Control Tab. Output boxes are
automatically selected when S/B ratios are greater than the
value specified in the Control tab. The selected results can
then be plotted or copied into Excel spreadsheets. The user
is also able to select or deselect individual results at will or
by using the “All On” or“All Off” buttons.
Fragmentation distribution curves for the selected
output can be automatically plotted by clicking on the
“Plot Selected” button.
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To copy data into Excel, the user must click on the
“Copy Selected” or “Copy All” buttons, open an Excel
sheet and use the paste option from within Excel.

As discussed above, standard fragmentation curves can be
plotted from within 2DRing by pressing on the “Plot
Selected” button. The output dialog is illustrated below.
As shown below, the output data copied into an Excel sheet
contains a summary of all input parameters, modelling
output parameters and fragmentation data for each burden
configuration and a compiled summary of burden versus
predicted uniformity, P10, P20, P50, P80 and P90 values.
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General Functions
2DFace incorporates a number of different functions to
facilitate the development blast design process:
Core Design Functions include grid size and grid
orientation settings, definition of drives with strings
functions, drilling mode functions, charging mode
functions, tie up functions and detonation simulation.
Editing Functions include the selection of objects (eg.
marking functions), deleting objects (eg. holes, charge
etc.), deleting drives and strings, changing the attributes
of objects (eg. visibility, colour etc.).
Viewing functions include zoom in and out, specify
zoom, go to position, centre design, redraw and query
functions.
The reporting functions include printer set up, print
the design window and turning object text on/off for
printing more information.
Data organisation functions include Microsoft Access
database storage plus general importation and
exportation facilities.
Design Area
Screen Layout
Figure 1.1 shows the screen layout of the main design area
of 2DFace. The window consists of a drawing area, title bar
(which has some status information), menu bar, tool bar,
status bar and scroll bar.
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This main window or drawing area is a section view of a
3D world defined by grid coordinates (ie. Easting, Northing
and Reduced Level (RL) in metres).
The menu bar contains all the functions available in
2DFace and it is divided into six items (ie. File, Edit,
Mode, Parameters, View, Marking, Tools and Help).
The tool bar consists of four items, the major design mode
buttons which are associated with mode functions in the
main menu bar; the parameters setting button which allow
the user to set the properties of a design mode (ie. drilling,
loading etc); the construction mode buttons which give the
user some construction options available for design and the
information mode buttons which allow the user to query a
design.
The status bar gives the user an indication of the current
design mode and construction option as well as design
properties such as current location, current construction
line properties, current anchor line properties and current
scale for the drawing.
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Title Bar
Menu Bar
Parameter Information Bar
Tool Bar
Major Mode
Buttons

Parameters
Button

Construction
Mode Buttons

Information
Mode Buttons

Current coordinates
Scroll Bar

Drawing Area

Selection Box

Status Bar
Scale

Figure 1.1 General Layout of the Main Design Window

Design Area Appearance
The following section describes the options available to
define the characteristics of the design area. (ie. Setting
mine coordinates, global coordinates, grid size, grid
orientation etc.). A number of tools are available in 2DFace
for this purpose and these are accessed via the
View+Options…menu item (see Figure 1.2 )
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Figure 1.2 Change options dialog

The Change options dialog allows the user to set up and
modify the drawing area in which a design is to be created.
This dialog contains nine options describing different
aspects of the design layout as outlined in Table 1.1 .
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Table 1.1 Change options dialog description
Option

Description

Grid
Dimensions
Grid Line
Grid Annotate
Visibility

Activates the Grid and defines the size of
grid intervals; East/West and North/South.
Selects the appearance of the grid lines
Option for defining grid text
Selects object type to make visible or
invisible
Selects the colour of the object type
Selects where object text is positioned in the
design layout
Adjusts some text sizes by a percentage
Selection box and mask properties
Axis indicator properties

Colour
Text
Size
Selection
Other

The Text position option contains dialog boxes which
allow the user to interactively select and position text
around an object as shown in Figure 1.3. Note that the text
will not appear until the relevant object visibility is turned
on.
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Figure 1.3 Text position dialog and options
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The Object colour option allows the user to change the
colour of all objects in the design layout. The standard
colour palette dialog is shown in Figure 1.4.

Figure 1.4 Colour palette dialog
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Global Construction Tools
This section describes tools that are generally used during
design creation such as object selection tools, viewing tools
and measuring tools. The user should be aware of these
tools to facilitate the design process.

Selection
Box
On/off

Selection
Mask
On/off

Selection Box
The selection box allows the user to quickly select a square
or rectangular region within the design area. It is toggled
(ie. turned on/off) by clicking on the selection box icon in
the tool bar.
Selection mask
The selection mask allows the user to select irregular
regions (ie. polygons of up to 10 vertices) within the design
area. It is toggled (ie. turned on/off) by clicking on the
selection mask icon in the tool bar or alternatively by
accessing the options dialog via the View menu item.
Goto Position
The “Move 2D cursor to location” dialog (Figure 1.5) is
activated via the View menu item (Ctrl+G). The position
dialog allows the user to move the 2D cursor to a specific
grid position. The user may move the 2D cursor to an
absolute coordinate or to a position relative to the 2D
cursor's current position. The relative move can be in
Cartesian coordinates (eg. Easting, Northing and RL) or in
spherical coordinates (eg. Angular move). To move to a
location, click on the “Move cursor” button.
The “Move 2D cursor to location” dialog also allows the
user to carry out a design action at a specific location by
clicking on the “do Action” button.
Note that if a drive has been selected, then the chosen
coordinate will be forced onto the face of the drive.
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Figure 1.5 Move 2D cursor to location Dialog

Anchor
The Anchor is a measuring tool that allows the user to
obtain bearings and distances from a start point to an end
point. It is toggled by clicking on the Anchor icon in the
tool bar.

Anchor

Specify Zoom
This option is accessed via the View menu item. The new
scale dialog is activated and it is shown in Figure 1.6. The
user may change the scale and click on the apply button for
the change to take place.

Figure 1.6 New scale option dialog
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The user may also change the current scale by double
clicking the scale shown in the status bar (see Figure 1.1).
Zoom In, Zoom Out, Previous Zoom
These options are also accessed via the View menu item
(eg. View+Zoom in... ). The default value for both zooming
in and out is “twice” of the current scale. (eg for a scale
1:750 ; 1:(750/2) for zooming in and 1:(750x2) for
zooming out).
If the selection or masking box is on, then the zoom in
option will automatically zoom into the selected region.
The user may also quickly zoom in and out of a region by
using the shortcut keys “Z” , “Shift+Z”. The previous
zoom state can be selected with "Ctrl+Z".
Centre Design, Select Nearest Object
The centre design option is used to automatically centre on
the screen all the objects of a design.. This option is
accessed via the View menu item or by pressing the [end]
Key. Similarly to move the cursor to the nearest object,
depending on the current mode (ie. string, hole, deck etc.)
the user must press the [Home] key or access this option
via the View menu item.
View Define
The user is able to view the design from different directions
by activating the choose view direction dialog (Figure 1.7)
via the View+define menu item. This dialog allows the user
to flick through several pre-defined views.
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Figure 1.7 New scale option dialog

Hole Marking
Applying changes to holes can be easily done with 2DFace
editing functions. For changes to occur, holes should be
marked. To mark holes, a number of options are available
in the Marking menu item:
Marked holes are shown with an “M” in the centre (see
Figure 1.8 below)
Note
The hole nearest to the 2D cursor can be individually
marked or unmarked by pressing the “M” and “U”
keystroke buttons respectively.
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Unmarked holes

Marked holes
Figure 1.8 View of marked and unmarked holes

Hole Dragging and Dropping
Marked holes can be dragged and moved to any position in
a drive by pressing and holding the right mouse button.
Redraw
Redraw is used to update the current screen. This option is
accessed via the View menu item or by pressing [R].
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Query Options
Two functions provide information on the properties and
components of a design (eg. hole lengths, hole diameters,
explosive charges, in-hole delays, etc) - the object query
and the design summary information.
Object Query
The individual object query function is activated by
clicking on the Information mode icon in the tool bar.
This option allows the user to obtain information about the
design for the different design modes available (eg. holes,
decks, in-hole delays, surface delays etc.). The user should
be in the appropriate mode.

Information
mode

Figure 1.9 Design Information dialog
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A typical information box is shown in Figure 1.9. In this
case the user is inquiring about hole information of a
particular design. As well as charge information of a
particular hole.
Note
For multiple decks or in-hole delays in a hole, clicking the
left mouse button will cycle through the individual items
in the hole.
Design Summary Information
The design summary information or object totals can be
activated via the View+Object Summary and Totals…
menu item. This option allows the user to obtain a
summary and detailed information about the design,
including drive information, hole details, decks and delays
(see Figure 1.10).
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Figure 1.10 Design summary information dialogs

The design summary information can be saved to a text file
or copied to the clipboard. This allows the information to
be accessible by any other application (ie. excel, word etc.)
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Loading & Saving
Designs can be loaded and saved via the File menu item..
The corresponding dialog boxes are shown in Figures 1.11
and 1.12.
Note that 2DFace has chosen to assign the extension of
*.2df for the Microsoft access database files. This does not
mean that the user cannot use the default *.mdb extension.

Figure 1.11 Open design dialog
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Figure 1.12 Save Design and more information dialog

When Saving a project, the overall design name and the
names of the relevant design components should be
specified (Note: by pressing enter after entering the overall
design name, the relevant design information names are
automatically added).
It is important to note that if no names are specified to the
relevant design information combo boxes (ie. Area design
name, Hole design name etc.) then that information will not
be saved.
The user may also specify different blasting scenarios for
the same overall design by choosing the item labelled
“new” before saving. The more information button (Figure
1.12) allows the user to insert extra information about the
overall design and individual blasting scenarios.
Importing and Exporting
2DFace currently allows the user to import string
information via a general importer.
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Importing String Information
To import string information, the user should access the
general string import option via the file menu item (File +
General string import). The select string file to import
dialog box is activated (Figure 1.13). The user must select
the ASCII file to be imported. The only requirement is for
the ASCII information to be in column format .

Figure 1.13 Sting file selection dialog

Once the file has been chosen, the import data dialog box is
activated showing the ASCII file information (Figure 1.14).
At this point the user should select the number of comment
lines and how columns are separated. The number of
comment lines can be chosen in two ways. The first is to
type a number in to the appropriate text box (# Comment
lines), or by clicking in the last comment line in the file
preview box and then clicking on the button next to the
#Comment Lines text.
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Figure 1.14 Import data dialog box.

Press [Next] to open the Data Definition screen (Figure
1.15), to specify the column names (eg. String ID No,
Easting, Northing etc..)

Figure 1.15 Import Strings - Data Definition Dialog
JKSimBlast
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The user should also specify the choice of string in the data
definition dialog box (Figure 1.16). That is, define whether
strings are defined by common values in a column, strings
are defined per line or whether the file has only one
string).

Figure 1.16 Import Strings - Data Definition Dialog

The next step is to define whether the strings are open or
closed by clicking the button How are strings closed ? …
The String closure definition dialog box is activated
(Figure 1.17). In this dialog box the user must choose
between four definition criteria :
All strings are closed if the number of points > 2
All strings are open
Strings are closed if the first and last point are within a
specified tolerance
Manually specify closed strings
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Figure 1.17 String closure definition dialog

The next step is to access the data exclusion list dialog
(Figure 1.18) by clicking on the edit exclusion button. In
this dialog the user is able to exclude information from the
ASCII file to be imported. There are some cases where
extra information is added to data files which is not directly
related to string coordinate information. This step is used to
filter out that type of information.

Figure 1.18 Data exclusion list dialog
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The next step is to select some string properties in the final
dialog box (Figure 1.19). This is to specify information that
is missing in the ASCII file but is needed by 2DFace. The
user can also do a conversion of coordinates to metres from
other units such as feet etc.

Figure 1.19 Final string information dialog

Finally all of the above import configuration can be saved
so that strings can be quickly imported without following
all of the above steps. (Figure 1.20)

Figure 1.20 Saving import configuration
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The configuration for a particular ASCII file extension is
saved in the Import.ini file. The comment can be used to
recall the source of a particular file extension
Exporting data
2DFace allows designs to be exported to 3X3Win for
analysis. This is done via the File+Export menu item
which activates the File Export dialog shown in Figure
1.21.
Note that 3x3Win project (*.prj) file extension is the
default export file type for analysis in 3x3Win.

Figure 1.21 Export data dialog
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Reporting
Printing
The design can be printed as shown on the screen, at the set
scale, including any visible view options such as hole
numbering or in-hole delays. Print design options and
printer properties must be chosen before printing.
The Print design window is accessed via the File menu
item (File +Print Design window..). The print design dialog
is shown in Figure 1.22 below.

Figure 1.22 Print design dialog
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The user must select the printer from the list available.
Margins can be set for the design page (these are in
addition to the unprintable area around the edges of the
paper).
A logo, timing contour scale, energy distribution scale and
a comment box can be printed in any of the corners of the
page. The logo is a bitmap file (Printlogo.bmp) in the
Auxfiles folders. This file can be replaced with any bitmap
file.
The comment box can contain any text information to
accompany the printed design, such as the blast name or the
designer's name, scale, etc.
The configuration for a printer can be saved for further use
at a later time. Click the save button , and then enter a
descriptive name for the configuration (Figure 1.23). Click
OK to save the configuration. An existing setup can be
recalled from the list of available configurations on the
Print Design dialog.

Figure 1.23 Save Printer Configuration dialog
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All printer configurations are saved in the file
2DBPrnConfigs.ini in the 2DFace folder. Different sets of
options can be created for the same printer or different
printers and stored in the file for later use.
A print preview can also be obtained by clicking on the
preview button (See Figure 1.24).

Figure 1.24 Print preview window showing a 3D energy distribution
contour and scale, the logo and a comment box.
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Design Input
Within 2DFace, the creation of a design follows a
systematic engineering approach, which can be divided into
the following steps:
Definition of the region to be blasted (Drive outline)
Blast hole drilling.
Selection and loading of explosives.
Selection and loading of delay detonators (down-hole
and surface sequence)
Area to be Blasted
2DFace allows the user to define the blast design region
with a number of CAD (Computer Aided Design)
functions. The procedure for defining the geometry of a
blast design in 2DFace includes importing and creating
strings and polygons, defining drive outlines and placing
text labels on the design area.
String Creation to Define Blast Regions
The boundaries of a drilling drive can be defined using the
“Area Mode” function. This option is accessed via the
Mode+Area menu item or alternatively by clicking on the
Area Mode Icon.

Area
Mode

The area mode function allows the user to create a string
outline. A string is a collection of two or more points
joined together by lines. Strings may either be opened or
closed. A closed string is defined as starting and ending at
a common point.
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There are two ways of creating a string outline to define the
geometry of the area to be blasted, namely:
Single
Line
Mode

Single line segment drawing: This method allows the
user to draw single line segments to define a single line
or a polygon. It is activated by clicking on the single
line mode icon
To draw a line, place the cursor at the position of the start
of the line , click the mouse or press [enter], move the
cursor to the position of the end of the line and click again
or press [enter].

Multiple
Line
Mode
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Multiple line segment drawing: This method allows
the user to draw polygons by joining multiple lines. It is
activated by clicking on the multiple line mode icon.
To draw a polygon, place the cursor at the position of the
start of the first side (the first point), click the mouse or
press [enter], move the cursor to the position of the end of
the side (next point) and click again or press [enter]. Repeat
this for each succeeding point, and close the polygon by
crossing any side.
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Figure 2.1 String

In line and polygon creation mode 3D and 2D coordinates
and line creation properties are displayed on the screen as
shown in Figure 2.1.
Note
To stop the line creation, press the Esc Key or if a closed
polygon needs to be created, then cross any of the earlier
line segments with the new one..
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Development Rounds (Drive Outlines)
Drives can be created from existing closed string
information and/or can be individually created.
Ring
Planes /
Drives /
Drill
Positons

Make
drive
outline

To create a drive from existing strings, the user must
activate the ring planes/drives/drill positions mode icon and
click on the make drive outline icon (see left). The user
may then click on the nearest string for it to be used as a
drilling drive. It should be noted that the string must be
closed and that the drive outline will become a new closed
polygon.
Single drives can also be created and positioned anywhere
in the design by clicking on the make drive outline icon.
The make drive outline dialog is then activated (Figure
2.2).

Updates current cursor
position

Figure 2.2 Make drive outline dialog

The "make drive outline" dialog allows the user to specify
a label, the dimensions, the orientation, the shape and the
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position of the new drive. The Grade/Centre line
intersection defines the origin for the points along the string
to be created and how far the left wall and floor is to be
from this point. The origin specified will be forced onto the
current ring plane automatically.
The numbers in the shoulder style option labelled height
and radius are relevant to the bezier line method and the
rounded shoulder method respectively (Figure 2.3a &
2.3c). The circle section takes the circle radius as being half
the new drive width.
The bezier line option will produce an arch with a height
given by the dimension (Ah) while the rounded shoulder
option uses the dimension as a radius and tries to fit a
quarter circle section of the given radius (Ar) at the
shoulders. If the radius for the shoulder circles is greater
than half the Drive width then one circle of the given radius
will be fitted at the top.
Figures 2.3 shows examples of the available arch types. In
all these figures the Height(H) is 4m and the Width(W) is 4
metres. Figure 2.3a, Ah = 1m, Figure 2.3b: Ar = W/2 = 2m,
Figure 2.3c: Ar = 1m and Figure 2.3d: Ar = 3m.

a) Ah = 1

b) Ar = W/2
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c) Ar < W/2

d) Ar > W/2

Figure 2.3 (a ,b, c & d). Various arch types possible

Specify
back of
drive

Specify Sections of Current Drive
The user is allowed to specify sections of the current drive
(ie. back and floor sections). To define the back of the
drive, the user must click on the "specify back of drive"
icon and select in a clockwise direction the region that
will define the back holes (see Figure 2.4). Similarly, a
floor region may be defined by selecting the " specify floor
of drive " icon.

Specify
floor of
drive
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Figure 2.4 Defining sections of drive outlines
(in this case the back of a drive)
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Drilling
Mode

Blast Hole Drilling
The creation and positioning of blast holes is carried out by
accessing the drilling mode function available in the
Mode+drill menu item or alternatively by clicking on the
drilling mode icon.

Current
mode
parameter

Before holes are created, it is essential to establish the
properties of holes by accessing the hole drilling dialog
(Figure 2.5 a,b,c,d) via the Parameters+drilling menu
item or alternatively by clicking on the current mode
parameter icon.

Figure 2.5 Hole drilling dialog

The hole drilling dialog enables the user to input all
properties attached to blast holes including type, length,
diameter, dip, bearing, etc.

178

JKSimBlast

2DFace

As shown in Figure 2.5 four tabs separate the options for
assigning properties to the creation of a development round
(ie. Single hole, Cuts, Multiple holes and Circle). These
options should be used in combination with the drilling
mode options represented by the icons shown below.
2DFace incorporates the option to define specific hole
types, including: Cut relief holes, Cut charge holes, Back
holes, Side holes, Floor/Lifter holes and Auxiliary holes
(see Figure 2.6). Hole properties such as diameter and
length can be set for these different hole types.

Single
Hole
Mode

Cut
Drilling
Mode

Holes
Along
Line

Holes
Around
A Circle

Figure 2.6 Hole drilling dialog

The user may also define a toe offset value (ie. from the
side walls, roof and floor) instead of manually adjusting the
dip and dip direction of a drill hole. To do this the user
JKSimBlast
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must click on the "activate extra toe offset" check box (see
Figure 2.6) and input a value in metres in the required
direction.

Single
hole
mode

Cut
drilling
mode

Single Hole Mode
Individual holes can be positioned anywhere in the drive
using the single hole construction mode which is activated
by clicking on the single mode icon in the tool bar.
Properties of the hole should be specified in the hole
drilling dialog. (Figure 2.5, 2.6).
Burn Cuts
Burn Cut designs can be added to a pattern by selecting the
Cuts option tab. Here the user can select from a number of
pre-existing saved burn cuts located in the
"JKSimBlast\2DFace\Cuts" folder. Cut files are ASCII files
that can be easily created by the user.
To attach a burn cut to a design, the user must select the
burn cut and assign the width and height (See Figure 2.7).
Select cut drilling mode, then position the cursor and click
in the area where the burn cut is to be drilled.
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.
Figure 2.7 Burn cut selection

A new burn cut can be added to the list by marking the
holes forming this cut and saving them through the tools
menu item (ie. Tools+Save marked holes to cut file…)
Figure 2.8 shows an example of a new burn cut being
created and added to the list.
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Figure 2.8 Adding new burn cut to the list

Holes
Along
Line

Multiple Holes
Multiple holes can be added automatically to the back, the
side walls, the floor and to defined lines by simply
selecting the "Holes along line" mode and defining the
criteria for drilling (ie. spacing or number of holes, Figure
2.9).
To automatically attach holes to the back, side walls, and
floor of a drive the user should:
1. Select the appropriate hole type (ie. Back hole) and
input the required properties (ie. diameter, length,
offset etc.). Also make sure that the "drill along line"
icon mode is on.
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2. Select the multiple holes tab and select the drilling
criteria (ie. number of holes or defined spacing
between holes)
3. Go to the design and click inside the drive, near the
region of interest (ie. the back, the left side wall etc.).
A confirmation box will appear indicating the number
of holes that can be fitted to this region and the spacing
between them. Click OK to accept.

Figure 2.9 Multiple holes drilling criteria

The multiple hole mode can also be used to automatically
drill a collection of auxiliary holes in a defined direction, in
this case the user should.
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Figure 2.10 Drilling holes along a line

1. Select the appropriate hole type (in this case auxiliary
holes) and assign the required properties. Also make
sure that the "drill along line" mode is on.
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2. Select the multiple holes tab and select the drilling
criteria (ie. number of holes or defined spacing
between holes)
3. Go to the design and click where the first hole is to be
created and move the cursor to define a line by clicking
on another point. Holes will automatically be attached
to this line. (See Figure 2.10).
Drilling Holes around a Circle
Multiple holes can be added automatically as a circle by
defining a radius and starting angle. (See Figure 2.11)

Create
holes
around
circle

Figure 2.11 Drilling holes around a circle

To attach holes to a circle, the user should:
1. Select the appropriate hole type (ie. auxiliary hole) and
input the required properties (ie. diameter and length).
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Also make sure that the "create holes around circle"
icon mode is on.
2. Select the circle tab and select the drilling criteria (ie
spacing on circle or number of holes around circle
3. Define a circle radius and a starting angle from the
horizontal. By default, the circle and segments to which
the user attaches the holes is not drawn, however the
user can change this by clicking on the check box
"draw circle and segments". Figure 2.12 shows the
circle and segment as a string
4. Go to the design and click inside the drive to define the
centre of the circle. (Figure 2.12).

Figure 2.12 Drilling holes around a circle
showing circle and segments as strings

186

JKSimBlast

2DFace

Selection and Loading of Explosives
The charging of blast holes is carried out with the loading
mode function. This function is activated via the
Mode+load menu item or alternatively by clicking on the
loading mode icon.
Before holes are charged, the user must select the type of
explosive to be used. This is done by accessing the loading
decks dialog (Figure 2.13) via the Parameters+Loading
menu item or alternatively by clicking on the current mode
parameter icon. This dialog also allows the user to edit
some of the explosive properties as well as charging
characteristics.

Loading
Mode

Current
Mode
Parameter

Figure 2.13 Loading decks dialog

Explosive types and properties are stored in a standard
Microsoft database file with a default name of Stock.mdb.
This file can be accessed and modified with the use of
Microsoft Access Database Software .
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Single
hole

All
holes

Marked
holes

The loading mode allows the user to load one hole at a
time, all holes at once, a group of marked holes or a group
of unmarked holes. These options can be accessed via the
loading mode icon selection in the tool bar and shown
below:
For single hole loading the user must click the mouse
button on the nearest drill hole to be charged and for all
other options, the user must click on the design window.
As shown in Figure 2.14, options for loading quantity
include: length of charge, length from the collar, mass in
kg, % of hole length and number of cartridges.

Unmarked
holes

Figure 2.14 Loading quantity options
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Selection & Loading of Delay Detonators
2DFace uses both in-hole and surface delays to design the
initiation sequence of explosive charges.
Downhole delays
The placement of downhole delays is carried out by
activating the downhole delay mode function via the
Mode+downhole delay menu item or alternatively by
clicking on the downhole delay mode icon.
Before holes are primed and down-hole delays inserted, it
is essential to select the type of delay element, connector
and primer to be used. This is done by accessing the
downhole delays dialog (Figure 2.15) via the
Parameters+downhole delays menu item or alternatively
by clicking on the current mode parameter icon.

DownHole
delay
mode

Current
mode
parameter

Figure 2.15 Downhole delays dialog
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Single
hole

Delay accessories are stored in a MS Access database with
a default name of Stock.mdb. The database can be modified
with the MS Access software
The downhole delays dialog also allows the user to edit
some of the delay connector and primer properties assigned
to a particular design.

All
holes

Marked
holes

Unmarked
holes

Surface
delay
mode

Current
mode
parameter

The downhole delay mode allows the user to insert
downhole delays one hole at a time, all holes at once, a
group of marked holes or a group of unmarked holes. These
options can be accessed via the downhole delay mode icon
selection in the tool bar.

Surface delays
Once holes are primed and downhole delays inserted, the
next step is to place surface ties between hole collars. The
placement of surface ties is carried out by activating the
surface delay mode function via the Mode+surface delay
menu item or alternatively by clicking on the surface delay
mode icon.
Before tying begins, the user must select the type of surface
delay element and the type of connection to be used. This is
done by accessing the surface delay dialog (Figure 2.16)
via the Parameters+surface delays menu item or
alternatively by clicking on the current mode parameter
icon.
Depending on position, surface delays are referred to as
inter-row ties or inter-hole ties, in addition the connection
of each surface delay can be specified to be bi-directional
or uni-directional (Figure 2.16).
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Delay accessories are stored in a standard Microsoft
database file with a default name of Stock.mdb. This file
can be accessed and modified with the use of Microsoft
Access Database Software.

Figure 2.16 Surface delays dialog

The surface delay mode allows the user to tie up the design
hole to hole or by multiple holes. These options can be
accessed via the surface delay mode icon selection in the
tool bar.
Surface ties can also be connected to nodes, which can be
used as ignition points or help on the positioning of ties.
Nodes can be added to a pattern by activating the drilling
mode function and the create node icon. The user can then
click in the position where a node is required.

Hole by
hole tie

Multiple
Tie-up

Create
node
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Engineering Tools & Analysis
A number of engineering tools have been incorporated to
the software to facilitate the revision, analysis and
improvement of development blasting patterns, these
include:
Image digitiser
Explosive energy concentration
Detonation simulation and time contouring
Image Digitiser
The aim of the image digitiser is to help define and input
the "as drilled" condition of a development face into
2DFace,. The aim is to be able to compare design vs actual
conditions and perform specific analysis.. The user is able
to access the image digitiser under the tools menu item (ie.
Tools + Digitise face image…).
In general the user must complete the following steps to
successfully obtain the as drilled condition of a face.
1. Open an image file (jpeg, gif, bmp,wmf, emf)
2. Specify centre point or origin (eg. grade line
intersection point)
3. Definition of top and bottom scales of the image
4. Definition of drive outline
5. Activate requirements for assigning extra drill hole
information
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6. Definition of drill holes (ie. relief , charged, auxiliary,
lifters etc.)
The items described above can be carried out by clicking
on the appropriate icon. Figure 3.1 gives a summary of the
icons included in the tool bar.
The user is able to zoom in and out to facilitate the
digitising process. (see Figure 3.1).
Specify origin
position

Open image file

Define drive
outline

Specify bottom
scale

Zoom out
Zoom in

Define burn cut
charged holes

Assign hole information
during digitising (optional)

Specify top
scale

Define back holes
Define side holes

Create holes and drive and
output to 2DFace
Define burn cut
relief holes

Define lifter holes

Define auxiliary
holes

Figure 3.1 Summary of icons in the image digitising tool

Figure 3.2 shows the digitising of an underground
development pattern. Note that the origin, the drive outline
and the top and bottom scales have been defined. After the
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definition of the origin, scales and drive outline. The user
may start defining each hole type (ie. cut relief holes, cut
charged holes, back holes, side holes, lifter holes , auxiliary
holes etc.). Holes are defined by clicking on a specified
position of the image. Different colours are used to identify
different types of holes.
Properties of drill holes such as diameter and length can be
set by clicking on the "assign hole information" icon (see
Figure 3.1).
Definition of cut charged holes

Definition of top and
bottom scale

Check lists
and design
detail

Drive outline

Figure 3.2 Digitising of development round image

Once the user has finished defining hole positions, the
2DFace output is obtained by clicking on the "create holes
and drive outline" icon (see Figure 3.1).
Figure 3.3 shows the corresponding "as drilled" output
displayed in 2DFace.
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Figure 3.3 Output of a digitised face
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Explosive Energy Distribution
2DFace incorporates two methods for calculating and
displaying the distribution of explosives in 3D space.
Theses methods are called static (3D) and dynamic (4D).
The static method calculation does not take timing into
account and assumes that all charges go off at one time.
This can be classified as the maximum energy distribution.
The dynamic (4D) method includes the time the explosive
detonated.
Explosive energy distribution may be expressed in several
units: kg/tonne, kg/m3, MJ/tonne, MJ/m3 and MJ/m2. The
first four unit types (excluding MJ/m2) available in the
explosive distribution model are analogous to the
conventional powder factor calculation (kg of explosive
divided by tonnes or volume of rock blasted), the fifth unit
is an Energy Flux value.
Static 3-D Explosive Distribution
The three dimensional explosive energy distribution of a
charge does not take timing into account and is determined
in 2DFace following the approached developed by Kleine
et al (1993).
The traditional powder factor calculation was extended by
considering a small infinitesimal segment of charge and
writing the equation for the resulting explosive
concentration at a point “P” for a sphere centred at the
charge segment, the general form of the equation is as
follows, (also refer to Figure 3.4).
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P
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r
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Equation (6) can be integrated and rewritten as:
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Figure 3.4 3D Explosive Energy Concentration at point P

Note
Special conditions apply to the above relationships at the
charge axis (ie. h=0) and at very large distances (ie. h
).
The explosive concentration at any point in 3D is
determined by solving the appropriate integrated form of
the equation for each explosive charge and summing the
values.
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Dynamic 4-D Explosive Distribution
The calculation of 4D explosive energy distribution follows
relationships developed in the 3D case explained earlier
with the difference that a time component is taken into
consideration. This time is called the cooperation time
between charges.
The Cooperation time referred to in the Dynamic (4D)
Explosive distribution dialog is a method used to weight
the energy produced by a deck according to it’s detonation
time. A first guess for this value of cooperation time can be
a value equivalent to the burden movement time seen in the
open cut style blasts. It is in effect how long adjacent decks
will contribute energy to a section of rock before the rock
has been moved out of the way or fragmented out of the
way.
Calculation of 3D / 4D Explosive Distribution.
To calculate or display the explosive distribution of a
particular section of a pattern, the user must perform the
following steps:
1. Define the calculation region using the trim box tool
7. Access the explosive energy distribution dialog vie the
tools menu (ie. Tools + Explosive Energy
Distribution…).
8. In the dialog box, create a new file or open an existing
one to store the information (see Figure 3.5)
9. Define calculation parameters such as grid resolution,
rock SG, and the location of the calculation plane along
the excavation heading.
10.Define the holes that will be included in the calculation
(ie. marked, unmarked)
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11.Select type of calculation (ie. 3D or 4D) and click on
calculate new data.

Click here to create
new binary file to store
calculation information
Open existing data

Calculation inputs
1. Grid resolution
2. Rock specific gravity
3. Plane distance along
drive heading

Type of analysis

Figure 3.5 Explosive energy distribution dialog

Note
Changes can be made to the explosive energy concentration
scale by clicking on the display tab (see Figure 3.5). The
following options are included in this dialog:
1. Change scale range and units
2. Change scale colours
3. Redisplay current file
4. Other displaying options such as drawing contours as
filled rectangles or pixel points and drawing holes after
contouring
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Figure 3.6 shows the 3D explosive energy distribution for a
development round 45 drill holes, 3.2 m in length with
51mm charged holes and 102mm relief holes. Burn cut and
auxiliary holes were charged with ANFO.
The input parameters used for this calculation included:
A grid resolution of 0.02m
A rock S.G. of 2.8
A distance along heading of 3.2m (ie. calculation plane
at the toe of holes)

Figure 3.6 Example 3D explosive energy calculation in 2DFace
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Detonation Simulation and Time Contouring
Simulation of the blast detonation sequence can be carried
out in 2DFace and allows the user to visualise and report
the detonation sequence. This function is activated via the
Mode+detonate menu option or by clicking on the
detonation mode Icon.
The characteristics of the simulation can be established in
the detonation simulation dialog (Figure 3.7), which is
activated via the Parameters+detonation simulation
menu item or alternatively by clicking on the current
mode parameter icon.

Detonation
mode

Current
mode
parameter

Figure 3.7 Detonation simulation dialog

In the detonation simulation dialog the user may define
characteristics such as: pausing at each event, pausing
between events, showing events in a time frame, showing
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all events, apply delay scatter factors, set up the time step
of a simulation and run Monte Carlo simulations of the
detonation sequence.

Start
Detonation
from
Nearest
hole/node

Start from
Current
Ignition
Point
Calculate
timing
contour
grid
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The position of the ignition point can be chosen and
changed by activating the “start detonation from nearest
hole” icon. If the user wants to re-initiate the blast from the
current position then the “current ignition point” icon
should be used.

Once the detonation mode is activated, the detonation
simulation is performed once the design is activated (ie by.
clicking on the screen where the design resides).

Timing contours can be quickly calculated and displayed
after a detonation simulation has been performed. To do
this the user must click on the "calculate timing contour
grid" icon.
Figure 3.8 illustrates the results of a detonation simulation
with corresponding timing contours.
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Figure 3.8 Detonation simulation showing timing contours

Timing contour properties can be adjusted in the detonation
simulation dialog box (Figure 3.7) by clicking on the
"contours" tab. Figure 3.9 shows the options of the
contours tab, these include:
Adjusting the scale range by resenting the scale to a
fixed set of values, adding and removing values.
Changing the properties of the contouring lines
Using marked or unmarked holes in the calculation
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Figure 3.9 Modifying contouring properties
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Overview
2DView is an extended analysis module for JKSimBlast. It
can display a blast as a plan or section, or in an oblique
view, as defined by the user. 2DView has many of the
same functions as the design modules:

Overview

open blasts and import data;
print plans and export data tables;
query hole data and run basic blast analyses;
cut/copy/paste objects.
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These functions operate in the same way as in the design
modules. However, 2DView cannot graphically edit a blast
- a design module, such as 2DBench or 2DRing, is
required.
2DView is also the viewing platform for two extended
versions of the analyses of JKSimBlast:
Explosive Energy Distribution, which calculates
contours of explosive mass or energy throughout the
blast, highlighting high and low concentrations; and
2DContour, which calculates contours for data attached
to blastholes, such as detonation time, mass or energy of
explosives, hole length, collar level, etc
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Opening a Blast
Opening a blast is similar to the design modules. In Opening a
2DView, blasts can be opened one a time, or a blast can be Blast
added to the current blast. Data can also be imported from
text files. Blasts cannot be saved from 2DView.
Open a Blast
Select >File >Open from the menu. From the Open
dialog, click the [Browse] button to select a blast database,
then select a blast name and scenario from the database.
Select [More Info] at any time to see any comments, etc.
attached to the blast. To open the blast, click [Open].

It is possible to open only part of a blast, or to combine
components from different blasts. To prevent part of a
blast from loading, [click] the relevant check box below to
remove the check mark. To load a component from a
different blast, click the relevant tab, then select a database
and component - all components for that type in the
database will be listed. Ensure that the check box for the
JKSimBlast
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component is checked, then click [Open]. Note that the
resulting display can produce peculiar results if the blast
components do not match each other.
Add a Blast
Blasts can be added to the current blast and viewed or
analysed together. All data is then treated as though
belonging to a single blast. This can be useful if reviewing
an entire bench, or comparing different blasts for
performance characteristics.
Select >File >Add Designs from the menu. Click the
[Browse] button to open a database - other databases can be
opened after each blast has been added to the list. Select a
blast name from the list below, and then select the scenario
if more than one is available. Blast components within the
a blast can be disabled via the check boxes. Summary
information from the selected blast is displayed on the
right. To add a blast, click the [Add To List] button.
Further blasts can be selected and added to the list, or
removed from the list if necessary.
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When the list is complete, click [Open Designs] to load the
data into the display. More blasts can be added if required.
Note that the blasts are loaded with their actual coordinates,
and so it may be difficult to view widely separated blasts.
This can be overcome by marking only the holes for one
blast, then >Edit >Cut and >Paste Relative the holes
adjacent to another blast.

JKSimBlast

211

2DView

Viewing a
Blast

Define View
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Viewing a Blast
2DView can display a blast from any direction. To set the
direction, select >View >Define. Also on the View menu
are options to select the display of Marked or Unmarked
Holes, and the Options settings, which control the display
(colour, visibility and style) of the blast objects, plus an
indicator of the orientation of the grid with respect to the
current display (on the [Other] tab). Both the Holes and
Options settings can be activated at any time.

Define View
Define shows a dialog box for controlling the orientation of
the display.
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Choose View
Several pre-defined views are provided in plan and section
- select one these and then click [Apply]. User Defined
Surface displays the blast on an oblique projection. In all
cases, the blast is projected onto a plane whose position and
orientation is defined by the values on the tabs below. Plan
and section views are affected by the values shown on the
[Centre] and [View Bounds] tabs; all tabs affect the User
Defined Surface view.
Centre
The centre of the display is defined by the east, north and
level coordinates. To adjust the centre position:
move the blast by scrolling, Centre Design [End] or
Goto;
centre the blast on an object [Home] - before changing
the view; or
enter new [Centre] coordinates.
JKSimBlast
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View Bounds
This controls the amount of data that is displayed.
Boundary planes are defined at a distance from each side of
the projection plane - any objects found between the
boundary planes are then displayed. The planes can be
activated or deactivated to display all objects by [click] on
the check box.
Angle From Centre
This represents a line from the current view centre to the
viewer’s position. It is the opposite of the direction from
the user to the centre position. Enter the bearing and
incline (dip) angles and press [Enter] or [Apply] to change
the view, or [click] the dial arrows to change the angles by
10° increments. The bearing will rotate continuously
through 360° and incline ranges from +90° to -90°.
Changing the angles will also change the View Position.
View Position
This is the coordinate position of the user relative to the
display. Changing the coordinates will also change the
[Angle From Centre].
Top Direction
This determines the orientation of the data around the
[Centre] position. This can be applied automatically,
where the program will create an appropriate view, or can
be applied manually. Unless a specific orientation is
required, it is recommended to set the direction to
automatic.
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Scroll Bars
The display can also be changed with the scroll bars below Scroll Bars
and to the right of the window. In a plan or section view,
hold down the [Shift] key and then [click] either end of the
horizontal scroll bar to rotate the display to the next view,
or [click] the vertical scroll bar to switch from plan to
section view.
In User Defined Surface view, hold down the [Shift] key
and [click] the scroll bar to rotate the display around the
centre, as though rotating a sphere around its centre point.
[Click] either side of a scroll bar to rotate by 45°, and
[click] the arrow icon at the end of a scroll bar to rotate by
1°; [drag] the scroll bar to change the angle by an
intermediate amount.
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Defining a View "Plane"
When a view is defined, the data is projected onto the
screen from that orientation, in a plane parallel to the
screen and with the cursor located in the plane. The cursor
can be moved to any coordinate position within the plane.
To draw a region in a particular plane, the view must be
defined and the cursor positioned in that plane. Follow the
steps below to set up a "plane".
For a horizontal plane
in Define View, select a plan view
enter the required level on the [Centre] tab and click
[Apply]
For a vertical section on grid (parallel to north-south or
east-west)
in Define View, select a section view
enter the required east or north coordinate in the Centre
tab and click [Apply]
For an inclined section (off grid)
(note: these instructions can be applied to a bench, ring or
face blast- alternatively, use a section view and adjust the
inputs for Bearing and Incline accordingly)
in Define View, select a plan view
place the cursor at a location in the final plane - use
GoTo to set the level, or [Home] to lock onto a hole
collar
press [spacebar] to exit from the design area without
moving the cursor
turn on the anchor, and press [spacebar] to enter the
design area
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use the mouse or GoTo (or [Home]) to place the cursor
at another point in the plane - the line from the anchor to
the cursor will therefore be in the plane
note the bearing of the line from the anchor to the cursor
in the status bar (east, north, level, bearing, dip,
distance)
press [spacebar] to exit the Design Area
in Define View, select User Defined Surface
in [Centre], enter the coordinates of the cursor from the
status bar (DO NOT click [Apply] yet)
select automatic in [Top Direction] (DO NOT click
[Apply] yet)
in [Angle from Centre], enter the Bearing from the
cursor position to your view position - this is equal to
the bearing from the anchor to the cursor plus or minus
90 degrees
enter an Incline for a non-vertical view plane: 0 is
horizontal, 90 degrees is looking up, and -90 degrees is
looking down
click [Apply]
The view plane is now parallel to the screen, and the cursor
will move within that plane.
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Printing
The display area can be printed as it appears, to scale, on
any Windows-compatible printer. Select >File >Print
Design Window from the menu. The printer can be setup
either from the Print dialog or from the Printer Setup
option. When completed, the configuration values can be
saved and recalled for later use. The values are saved in
the file PrnConfigs.ini in the main JKSimBlast folder.
Click [Preview] at any time to view the print output on the
screen. Press [Esc] to return to the program. Display
options, such as object visibility or zoom scale, can be
changed while the Print dialog is active - just drag the
dialog out of the way and make the changes.
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Margin
This sets an extra margin around the page area, in addition
to the non-printable area for the printer.
Annotation
This option controls the position of the logo and the
comment box. The size and contents of the comment box
are entered below. Note that the actual text is not saved
with the printer configuration. The logo is a bitmap file
PrintLogo.bmp in the AuxFile folder - this can be replaced
with any suitable bitmap file.
Explosive Distribution
This controls the position of the explosive energy
distribution scale on the page – [drag] the black rectangle
to the required position.
Contour
This control operates in the same manner as the explosive
distribution control above.
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Calculation Region
A calculation region is a bounded plane used in 2DView to
define a set of grid points for a contour or an explosive
energy distribution. Values at the points are weighted by
the inverse of the distance from the blast data, such as hole
length, detonation timing, explosive mass or energy, cost,
etc.
In contouring, the selected value is applied to the entire
length of the hole to calculate the contours in a 2D plane.
Therefore, in plan view, the value appears to be assigned to
the hole centre; in section view, the value appears as a line
along the length of the hole.
For an energy distribution, the explosive column is treated
as a series of infinitely small pieces of explosive, each with
the properties of the deck. The "contours" are calculated in
a 2D plane but are weighted by the inverse of the square of
the distance of the grid point in 3D from all explosives
surrounding it. The closer a grid point is to a piece of
explosive, the higher the value. Therefore, points will have
fairly constant values close to and along the length of a
deck; and points between a group of holes or near the
centre of the blast will have higher values than points
around the outside of a blast.
The representation of a 2D contour is thus different from an
energy distribution, although the results appear to be the
same. For example, for evenly spaced holes in plan view
(such as an open cut blast), a contour will appear the same
for calculation regions at the hole collars or toes. An
energy distribution will be different for each region
because the concentration of explosive is higher at the toes
than at the collars, above the stemming.
The distance between points, or resolution of the grid,
affects both the smoothness of the resulting contours and
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the speed of calculation. While a higher resolution (more
points) gives a smoother pattern, it will take longer to
calculate. A resolution between one quarter and one tenth
of the distance between the blast holes will give an
acceptable result in a short time, depending on the size of
the blast. The resolution can then be fine tuned for further
calculations.
Creating a Calculation Region
There are two methods for creating a calculation region - Creating a
from an existing polygon, or draw a new region. The Calculation
polygon method is the easiest, and the region can then be Region
modified to adjust its position. This is most useful for
creating multiple regions parallel to the original design
plane in a blast design module - the polygon must be
created in the design module. To create a region in a
different plane, either draw a polygon in a design module,
using GoTo to position the cursor, or set up a User Defined
Surface in 2DView and draw the region on that surface.
Regions used in 2DContour cannot be saved, and must be
recreated each time.
To save a region for future
calculations, one solution is to create several polygons in a
design module and save these to separate scenarios - these
can then be added to the current blast (/File > Add Design).
Alternatively, regions used in Explosive Energy
Distribution can be saved to a database and recalled, with
the calculated values, for future display. Regions from an
energy distribution can also be used to calculate and
display a contour.
Polygon Method
To create a region from a polygon, first draw a polygon in a Polygon
design module such as 2DBench or 2DRing, and save it in Method
a blast database. Then, open or add the blast in 2DView.
An alternative is to create a polygon and save or copy it as
a text file of coordinate point values, and then import the
JKSimBlast
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file as a string file or paste the string. Place the cursor near
the polygon - use GoTo if it is difficult to select a particular
polygon from several in the blast.
In the Edit menu, select Make Region From Nearest
Polygon. This will create a region at the same position as
the polygon. A form will be displayed to enter a name for
the region, the separation between points (resolution) and
the specific gravity of the rock. The name can be used to
identify different regions. A resolution of about one
quarter of the distance between blast holes will give
reasonable results in minimum time, depending on the size
of the region. The rock density is used in the energy
distribution calculation.
The region can be removed at this stage by clicking
[Cancel], or any region can be removed by placing the
cursor near it and pressing [Backspace].
Multiple regions can be created from a single polygon, and
then modified (see below).
Draw a Region
Draw a Region A region can be drawn in the current view plane (see
Defining a View "Plane"). The drawing method is similar
to a polygon, but allows sides to cross over.

To draw a region, [click] on the [Start…] button on the
toolbar. Place the cursor at the start position (note the east,
north and level coordinates), [click] or press [Enter] for the
first vertex, then move the cursor to the other vertices and
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[click] or press [Enter] again. GoTo, [Home] and the arrow
keys can be used to move the cursor.
The final step is to close the region form the last to the first
vertices. To close the region, [click] the [Close…] button
on the toolbar or press [Esc].

After closing the region, in the form enter the name, point
separation and rock density (see above).

The region can be removed at this stage by clicking
[Cancel], or any region can be removed by placing the
cursor near it and pressing [Backspace].
Modify Regions
All of the data associated with a region can be modified. Modify
Select Modify Regions from the Edit menu. A form Regions
appears showing details of each region: name, point
separation, rock density (Region Extra data), and
coordinates of each point (Region Points). The nearest
region to the cursor will be automatically selected, but any
region available can be selected from the drop-down list.
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The region extra data can also be modified separately,
either from the Edit menu or the toolbar.

To change the extra data, simply type in new values. Click
[Update Region List] to add the new name to the list.
To modify a point, first select the point by [click] on the
row, and then the [click] the type of modification required:
[Move Point] Absolute : enter a new coordinate position
[Move Point] Relative : enter a step coordinate amount
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[Move All Points] : apply a step coordinate amount to
all points simultaneously
[Remove Selected Point] : removes the point from the
region, to a minimum of three points
[Set] : sets all points to an absolute coordinate for east,
north or level
Information on a region can be checked by placing the
cursor near the region and clicking the [Query] button
.
The display will show the region name, specific gravity,
resolution, perimeter length, area and number of points.
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Explosive Energy Distribution
The Explosive Energy Distribution (EED) analysis
produces a contour of the concentration of explosive mass
or energy throughout the blast.
The calculation is
performed on a 2D plane, defined by the user, but taking
into account the full three dimensional spread of the
explosives in the blast.
It is possible to calculate the three dimensional distribution
of explosive energy around charged blast holes in much the
same way as electric potential fields can be determined
around charged wires. Each column of charge is treated as
a source of energy which spreads out with only geometric
attenuation. The equations can be solved in terms of
energy density or mass density to give results expressed in
megajoules per tonne of rock or the more common
kilograms per tonne of rock. Results are also given in
megajoules and kilograms per cubic metre, and megajoules
per square metre. The resultant contours of explosive
distribution are fully three dimensional and can be used as
an effective design tool to determine burden and spacing
values, to check for anomalous charging in a blast design,
or to quantify fragmentation or damage in sections of a
blast under local conditions.
It is a simple matter to set or alter any explosive's mass and
energy densities and to alter the rock density to suit every
application. The program calculates and displays the
contours in colour in any calculation region which can be
inserted in or around the blast. The contour levels can be
adjusted as can the resolution with which the final image is
produced. Calculation results can be saved to a database
for later recall or used in other analyses.
An example of an explosive distribution analysis is
provided in the figures below. These show a wall in an
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open cut mine after removal of the blasted rock. Note the
traces of the blast holes in the central portion of the photo.
The blast holes were charged with 2 metres of bulk ANFO
at the bottom, with the remaining top 8 metres charged with
decoupled cartridges to reduce the overall energy. This has
resulted in high energy levels at the base of the blast and
undercutting of the wall. Note also the damage in the
upper section of the wall, caused by over charging of the
toes of the blast holes in the previous bench, similar to this
blast.

Starting a Distribution Calculation
The first step in starting an EED analysis is to create a Starting a
calculation region in the required location. Some standard Distribution
Calculation
locations for calculation regions are:
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collar, floor, toe or mid-charge level in a bench or face
blast;
in the section plane of the first, middle or last row or
ring in bench and ring blasts;
at the design location of the walls or new face around
any type of blast.
The results of the analysis can then be compared visually
with the blast performance at these locations, to help
quantify fragmentation, damage or overbreak.
Calculation Parameters

Marked / Unmarked Holes
This determines which holes are included in the
calculation. Check both boxes to use all holes in the blast.
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Regions
Calculate for only the nearest region to the cursor, or for all
regions. This is useful if several regions have been defined
at different elevations or orientations (such as floor and
wall regions).
Energy Distribution Type
3D assumes that all decks contribute equally to all points in
the region (static analysis), with the nearest decks having
the greatest influence (geometric attenuation). 4D adds a
timing effect to the 3D calculation to reduce the influence
of decks that detonate before or after the nearest deck to a
grid point. The cooperation time is a characteristic of the
rock mass properties, and can be approximated to the first
burden movement time. See 4D Energy Distribution
(below) for a more detailed explanation.
Store Results
The results of the calculation can be stored in a results
database or a temporary file, then one result set is recalled
for display. The results are stored more quickly in a
temporary file, but a database offers long term storage that
can be recalled at a later time, plus the results can be used
for other purposes.
To store to a temporary file, ensure that the box is
unchecked, and click [Continue...]. The results will be
stored in the file "binary.tmp" in the "Results" folder. This
file will be overwritten whenever a new calculation is
performed.
To store in a database, check the box, click the browse [...]
button and enter or select a database file, and select or enter
a new result name for the set of values. If a file name
extension is not specified for a new database, then ".eed"
will be automatically added to the file name. Check the
JKSimBlast
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[Remove...] box to ignore calculation results less than the
value shown; this will reduce the amount of space required
in the database. Click [Continue...] to calculate the values.
The display will show the grid points as their positions are
determined, then the progress of the energy calculation and
storage (for a database) is shown. When this is completed,
choose a result to display, modify model display
parameters if required, and activate the scale dialog to
control the range and colours (see below).

Displaying
Results
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Displaying Results
Results can be displayed in any view and, once saved, can
be recalled at any time, regardless of the current blast.
However, only one result set can be displayed at a time.
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Choosing Results
This step is necessary to replace any previous results still in
memory. Initially, the latest result will be automatically
shown. Check the box to load the results from a database,
select a database, and select the result set from the
database. If the box is left unchecked, then the results will
be recalled from the temporary file "Results\binary.tmp".
Finally, select the initial units to be displayed.
Model Parameters
The model parameters are used to define how results are
displayed. Usually, zero points should be ignored and data
points are shown as filled rectangles. The last option is to
indicate whether the holes should be redrawn after the
results have been displayed.
Scale
The Scale dialog defines how the results are displayed.
Values can be entered manually in any field, or the range
can be equalised between the minimum and maximum
values. Any range can be disabled by clearing the check
box.
The Relative Area shows the percentage of the calculation
area occupied by each range. These values can be used to
compare results for different regions.
The displayed units can be selected from the list - standard
units are kilograms per tonne (kg/t), kilograms per cubic
metre (kg/m3), megaJoules per tonne (MJ/t), megaJoules
per cubic metre (MJ/m3), and megaJoules per square metre
(MJ/m2).
The dialog can be reduced to the scale only, by [right-click]
on the dialog and selecting Scale Only from the pop-up
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menu. Other options for the scale are then added to the
pop-up menu from the new dialog.

4D Energy
Distribution

4D Energy Distribution
The 4D Energy Distribution is based on the 3D
Distribution (which is a distance weighted calculation of
the energy around a blast hole), but includes a weighting
with respect to the time a deck detonated. A detonation
simulation must be run beforehand in a design module to
create the detonation times required for each deck of
explosives.
First, the calculation points are determined for the region.
For each calculation point the nearest deck is found. The
time that this deck detonated is used as a reference time tnd
in the equation below. Then, for every explosive deck at
time td in the timing simulation, the 3D Distribution value
for the position is calculated and multiplied by the term:

where
td = detonation time of deck
tnd = detonation time of nearest deck to calculation
point
tc = cooperation time
The graph of this weighting function is shown below. The
cooperation time affects how steeply the weighting goes to
zero and is the time interval within which decks adjacent to
a detonating deck will assist in the fragmentation of the
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rock mass. After this time interval the interaction of decks
reduces significantly due to the movement of the rock
mass. The time is approximately the time to first burden
movement and is very dependent on the rock mass.
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2DContour
2DContour is the hole contouring analysis module of
JKSimBlast. It allows the user to create contours of data
attached to blast holes, either as lines or filled regions. The
available contours include such values as detonation time,
hole length, and total explosive mass and cost.
The program can also calculate contours of other userdefined data for a blasthole added to the blast database,
such as drilling time, penetration rate, or water depth.

To create a contour, first load a blast, set the orientation of
the view, then create a calculation region. Select the data
to be contoured and start the calculation. To display the
results, set the scale and type of display.
A calculation region is used to create a set of grid points for
calculation of a contour. Values at the points are inversely
weighted by the distance from the blast data, such as hole
length, detonation timing, explosive energy, cost of
detonators, etc. Therefore, the closer the point is to a blast
hole, the closer is its value to that of the blast hole. To
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calculate the contours, the selected value is applied to the
entire length of the hole. In plan view, the value appears to
be assigned to the hole centre; in section view, the value
appears as a line along the length of the hole.
The distance between points, or resolution, affects both the
smoothness of the resulting contours and the speed of
calculation. While a higher resolution (more points) gives
a smoother pattern, it will take longer to calculate. A
resolution of about one quarter of the distance between the
blast holes will give an acceptable result in a short time the amount can then be fine tuned for the desired result.
Contour Control
The contour control is used to select a value for contouring Contour
and the extent of influence of the data over the contour Control
calculation.
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Contour Position With Value
Select a value from the drop-down list. The standard
values are shown below. The units for the selected value
are shown on the right.
Grid Interpolation
The user can control which holes are included in the
calculation - tick both marked and unmarked for all holes.
Interpolation shadowing is used to exclude holes from the
calculation from the opposite side of holes relative to the
grid points. The influence distance determines how many
holes are included in the calculation of a contour value at a
grid point. To reduce the time of calculation, uncheck the
interpolation shadowing and set the influence distance to a
value just greater than the maximum distance from a point
to the surrounding holes (usually the burden or spacing
distance).
Current Contour Extents
This shows the maximum and minimum values for the
contours, based on the range of data values from the blast
holes for the selected contour. Click [Reset Scale] to
update the range if a different contour has been selected.
[Calculate Contour Surface for All Regions] starts the
contour calculation. The display will show the points in
the visible surface surfaces as the calculation
progresses.
[Remove All Contour Surfaces] deletes all contours.
Use this if the regions have been modified or new
values have been selected.
Values
The following standard values for contouring are calculated
from the blast data:
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Actual Downhole Connection Length Used (m)
Average Detonation Time (downhole) (ms)
Charge Density (average) (kg/m³)
Collar Easting (m)
Collar Level (m)
Collar Northing (m)
Cost of Charges ($)
Cost of Connections (downhole) ($)
Cost of Delays (downhole) ($)
Cost of Primers (downhole) ($)
Cost of Stemming ($)
Delay Actual Time (minimum downhole) (ms)
Delay Nominal Time (minimum downhole) (ms)
Delay Number (minimum downhole)
Energy (total) (MJ)
Hole Bearing (°)
Hole Detonation Order
Hole Detonation Time (minimum) (ms)
Hole Diameter (mm)
Hole Dip (°)
Hole in Row Number
Hole Length (m)
Length Of Charge (total) (m)
Length Of Stemming (total) (m)
Mass Of Charge (total) (kg)
Mass of Stemming (total) (kg)
Nominal Detonation Time (downhole) (ms)
RBS (average)
Row Number
RWS (average)
Stemming Density (average) (kg/m³)
Supplied Length Of Connections (downhole) (m)
Surface Delay Detonation (minimum) (ms)
Toe Easting (m)
Toe Level (m)
Toe Northing (m)
VOD (average) (m/s)
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Contour Scale
The contour scale is used to control the appearance of the
display - contour ranges, lines or fill, colours, and holes and also shows the amount of the calculation region
covered by each range.

The actual value of each contour range can be modified.
For filled contours, a colour is assigned to values between
the minimum and maximum for each range - these can be
changed by entering a new value directly in the cell. For
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line contours, only the minimum value is used to determine
the contour.
To set equal ranges for the entire display, enter a minimum
value for the first contour and a maximum value for the last
contour. Click the [Equalise ...] button to set the ranges.
The values can be greater than or less than the current blast
extents. This can be useful for zooming in and showing
greater detail in a smaller range.
For filled squares, the percentage of the region area
covered by each colour is displayed on the right of the
scale. The total area of the region can be shown in the
[Query] dialog
To change the colour, place the mouse pointer over the
colour square and [double-click]. Select a new colour from
the display.
The check next to each range determines whether the
contour is displayed.
Draw Holes After Contours will redisplay the blast holes
on top of the contours.
The current contours can also be displayed from the
Contour menu - select Display All Contours.
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Adding Custom Contour Values
The standard contours are calculated directly from the blast
data. However, other values can be added to the database
and then displayed in the list of values and contoured. The
values must be in the form of a single value per blast hole.
For example, the figure below shows the total amount of
soft rock in each blast hole, where each metre of drilling
was classified as one of four rock types: soft, medium, hard
and very hard. For each hole the total amount for each type
was then cumulated, and the four values added to the blast
database.
To create a custom contour, MS Access or another program
to modify the Access databases is required. The data to be
contoured will be added to the Holes table in the blast
database, but must also be described in the Extra Hole Data
Definition table. Follow these steps:
1. Open the database containing the blast.
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2. Open the Extra Hole Data Definition table. In
Microsoft Access, select the table and click [Open].
Enter a name for each data value under Field Name,
and a units of measurement for display under Field
Units. The ID number will automatically update for
each record (row). The fields can be entered in any
order.
3. Open the Holes table. In Microsoft Access, select the
table and click [Design]. Add a field (column) for each
of the data values in the Extra… table. The name of
each field must be exactly the same as that entered in
the Extra… table.
4. Open the Holes table for data entry. In the View menu,
select Datasheet. Enter the values for each hole under
the new columns. If the table contains more than one
set of hole data, check the Designs and Options tables
to determine which hole records belong to the relevant
blast. The data can be copied and pasted as a column
of data from another application if properly organised
beforehand, such as Microsoft Excel.
5. Close the Holes table, ensure that it has been saved and
exit the program. Open the blast in 2DView, create a
region and check that the new data appears in the list of
values on the Contour Control. Select the contour
value and continue as with standard values.
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Overview
TimeHEx (Time vs Holes and Explosives) calculates the
mass of explosive or number of decks detonated within a
time interval. As each deck is detonated, any decks after
that time and within the time interval are cumulated for that
detonation time. This is repeated for every deck to the end
of the blast. The maximum value for the blast, known as
the Maximum Instantaneous Charge (MIC), is often used as
a controlling factor when creating a blast design.

Overview

TimeHEx main window

The basic functions of TimeHEx are also included in the
design modules of JKSimBlast, but the program provides
some extended analyses. These are an adjustment for the
arrival time of the detonation vibrations at a point of
interest, and a cumulative plot of the bar chart that shows
the rate of explosive consumption in the blast.
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Maximum
Instantaneous
Charge

Maximum Instantaneous Charge
The first step is to open a blast from a blast database. A
detonation simulation with a Monte Carlo analysis must
have been performed on the blast.
Open a blast from a JKSimBlast blast database. Select the
database, then the blast name and scenario. A detonation
simulation must have been calculated before the blast can
be opened in TimeHEx.
Reload the current blast. This allows the user to make
modifications in a design module and reload for analysis
with one click.
Save the data from the current chart to a text file. The data
is formatted in tab separated columns, suitable for opening
in a spreadsheet.
Print the current chart. The print layout can be modified
from Print Preview.
Preview the chart for printing and modify the print layout.
Note: [click] the Preview button again to return to the main
display.
Set the display options: colours, grid lines and hole size.
To change a colour option, [double-click] the box. The
options can be saved and recalled as a scheme in the file
TimeHEx.ini. Multiple schemes can be created.
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Set the time interval for the current analysis calculation.
Either select a time from 0 to 9 ms, or select "other" to dial
any time from 0 to 1000 ms.
Show the design view, a plan of the current blast. The
view can optionally show grid lines, strings, text labels and
surface delays. The size and colour of blast holes are
defined in the display options.
Display the chart with charge mass on the vertical axis.
Display the chart with number of decks on the vertical axis.
Displays the bar values as cumulative mass or number of
decks, with zero time interval. This shows the total amount
detonated up to any time in the blast.
Calculates the gradient (or slope) from the selected bar to
the previous bar. This is equivalent to the detonation rate,
expressed as a mass or number of decks per millisecond.
Calculates the average gradient for an area of the chart.
[Click] a bar for the start point, then [drag] sideways to
select an area. The result is equivalent to the rate of
average consumption for mass or number of decks per
millisecond.
Select a point for calculation of the chart relative to a point
of interest. Either select a pre-defined text label, or enter
the coordinates for the point ("other"). The function uses
the detonation time plus the distance from each hole collar
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to the point of interest divided by the vibration velocity
through the ground to calculate an arrival time for each
deck at the point.
travel time (ms) = distance (m) x 1000 ÷ velocity (m/s)
arrival time (ms) = detonation time (ms) + travel time (ms)
The arrival time is then used instead of the detonation time
to recalculate the bar chart. To select a new point,
[right-click] the button on the tool bar and [click] on a new
point.
Set the wave transmission velocity through the rock, to
calculate the arrival time chart.
Enter the parameters for calculation of blast-induced
ground vibration and airblast using the scaled-distance
formula. The calculation can be performed at a fixed
distance, or relative to a point of interest - either select a
pre-defined point (label) or enter the coordinates.
Display the ground vibration and airblast values for a
selected bar in the chart. [Drag] to move the text to another
location in the chart.
Query the values and data for a bar in the chart, or for a
blast hole in the design view. In the chart, [click] on any
bar to show a text box of the data. The arrow keys can then
be used to move to the next bar, or [click] again to move
the cursor with the mouse.
In the design view, [click] any hole to see all data for the
hole and a schematic display of the decks and downhole
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delays. The data in the text box can be copied and pasted if
required ([drag] across the text to select it, then
[right-click] for the pop-up menu).
In the chart, find the holes in the design view associated
with a bar. Place the cursor over a bar to highlight the bar
and show the linked blast holes. The holes are coloured
according to their position in the chart relative to the
highlighted bar: holes that have "exploded" are to the left
of (before) the highlighted bar; "exploding" holes are
linked to the highlighted bar; and "unexploded" holes
(after) are in the default colour. [Click] on a bar to use the
arrow keys to move through the blast. (Note: select 0 ms
time window, [click] on the first bar, and use the arrow
keys to "replay" the detonation simulation).
In the design view, find the bar in the chart for a hole. This
will be at the detonation time of the hole - note that the bar
may include other holes.
Supplier, version and license information.
Activate on-line help.
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Design View
The Design View displays a plan of the current blast. The
view can optionally show grid lines, strings, text labels and
surface delays. The size and colour of objects in the view
are defined in the display options in the main chart
window. The plan will automatically resize to fit the
design view window. The status bar shows the coordinates
of the mouse pointer, the selected hole label and record
number, and the grid spacing.
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Toggle the visibility of grid lines.
Toggle the visibility of strings.
Toggle the visibility of surface delays.
Toggle the visibility of text labels.
Query the data for a blast hole. [Click] any hole to see all
data for the hole and a schematic display of the decks and
downhole delays. The data in the text box can be copied
and pasted if required ([drag] across the text to select it,
then [right-click] for the pop-up menu).
Highlight the bar in the chart for a hole, corresponding to
the detonation time of the hole.
Activate on-line help.
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